Part II

Getting Your Project Going

IN THIS PART

Chapter 3
Creating a New Project

Chapter 4
Building Tasks

Chapter 5
Creating Resources and Assigning Costs
Creating a New Project

Now that you have some project management concepts under your belt and you’ve taken a stroll around Project’s environment, you’re ready to create your first schedule. Before you type any information into a Project schedule, however, you should first assemble the relevant information about your project. Then you can open a new Project file and begin to build your project tasks by using a simple outline structure.

In this chapter, you begin to build your first Project schedule and find out how to save your project. At the end of the chapter, you read about how to take advantage of Project’s Help system.

Gathering Information

As you read in Chapter 1, several elements must be in place before you can begin to build a project schedule. In addition to determining whether the project should be undertaken, identifying the project’s stakeholders, and gaining stakeholder support, you and your team must understand the overall goal and scope of the project so that you can clearly lay out the steps that lie between you and that goal. You’ll find delineating the major steps of the project a good place to start. Don’t worry about the order of the tasks at this point — just brainstorm all the major areas of activity. Suppose that you’ve been given the project of organizing an annual meeting for your company. You may take the following steps:

- Book the meeting space
- Schedule speakers
- Arrange for audiovisual equipment
Part II: Getting Your Project Going

- Order food
- Send out invitations
- Mail out annual reports

The last item on that list raises the question of scope: Is it within the scope of your project to create the annual report, or are you simply supposed to obtain copies of a report from the marketing department (for example) and mail them to stockholders before the meeting? In some corporations, the person who is responsible for organizing the annual meeting is also responsible for overseeing the production of the annual report. Be sure to answer questions of scope and responsibility at this stage of your planning.

For this example, assume that another department is creating the annual report. You simply need to make sure that someone mails copies of the report to all stockholders before the annual meeting.

Determining detail tasks

After you’ve prepared a list of major tasks — Project calls them summary tasks — break them into more detailed tasks. Take one of the items on the list — Order food, for example — and consider how you can break down this task. How detailed should you get? The following is one possible way to subdivide the Order food task:

- Create a budget.
- Determine a menu.
- Select a caterer.
  - Send out requests for bids.
  - Receive all estimates.
  - Review estimates and award contract.
- Give final head count to caterer.
- Confirm menu one week before the meeting.

Could you do without the detailed tasks under Select a caterer? Do you need more details under Create a budget? Those decisions are up to you; they’re based on your knowledge of your project and procedures. However, keep the following points in mind:

- Create tasks that remind you of major action items, but don’t overburden yourself with items of such detail that keeping track of your schedule becomes a full-time job. That’s the purpose of daily to-do lists.
- Include milestones to mark off points in your project. For example, the Review estimates and award contract task under the summary task Select a caterer is a milestone — it marks a point in time by which you want to have made a major decision. If that time comes and goes and you haven’t selected the caterer, will missing this deadline affect other subsequent tasks? If so, including that milestone could be vital to your success.
• Include tasks that management should know about, because you’ll use the Project schedule to report progress. If your boss wants to see that you’ve sent out a purchase order to the caterer per your new Accounting Department procedures, you may want to include the task (even if you don’t think this level of detail is all that important).

Establishing time limits

When you have a good working idea of the tasks involved in your project, you still need some idea of their timing. Should you allow two weeks for caterers to reply with bids? Not if you have only three weeks to organize the meeting. You may want to approach determining task timing by building an initial schedule in Project, assigning time to tasks, and seeing how close you can come to your deadline. If you’re way off, you can go back and tweak the timing for individual tasks until your schedule works.

Caution

You may be tempted to trim time off your tasks to make them fit a deadline, but this approach tends to produce an unrealistic schedule. What should you do? Use the initial schedule to convince your boss that you need more time, money, or resources to complete this project on time. If he or she wants to trim time from a specific task to meet the deadline, you might have grounds to ask for more help.

At this early planning stage, get any information that you need to assign timing to tasks. For example, contact vendors or subcontractors to get their timing estimates, which you need to reflect in your schedule. If your project has a drop-dead completion date, you should be aware of it. However, you can leave it to Project to show you whether your estimates work in an overall schedule.

Lining up your resources

When you build a Project schedule, you need to know what resources are available to you, as well as their costs. You don’t necessarily need to know these resources by name, but you should know, for example, that your construction project needs three engineers at a cost of $150 per hour and one piece of earthmoving equipment at a daily rental cost of $450.

Be sure to identify these resources and assign them to individual tasks early in the project-planning process. Find out anything you can about their availability: Are some of them available only half-time for your project? Will all the engineers be unavailable during the third week of August because of a professional conference? Is one resource available for most but not all of your project due to other work commitments? Research the cost and availability of resources as much as possible as you begin to build a project.

Cross-Reference

For more information about identifying resources and assigning them to individual tasks, see Chapters 5 and 25.
Looking at dependencies

Finally, before you enter project information into a schedule, be aware of relationships among tasks. Does the CEO have to approve the menu before you book the caterers? Are you required to wait three weeks after applying for a permit before starting construction on a building? If your project faces issues involving the order and relationships of tasks, you will save yourself some headaches down the line and build a more realistic schedule if you can identify these obstacles now.

Opening a Project File

You can start a project file in a couple of different ways. In this section, you first see the “usual” way to start a file. Then I cover how to use templates with project files.

Opening a project file — the usual way

Okay, you've done your homework. You've made some notes about your upcoming project's tasks, timing, resources, and dependencies. You're ready to start building your first schedule in Project. Choose Start ➤ All Programs ➤ Microsoft Office ➤ Microsoft Project 2010. You see the main Project window, where you can begin building a task outline.

Other ways to start projects

You can base your project on one of the templates available for Project 2010. Templates contain “standard” information to help you get started quickly. Instead of entering tasks, you may need only to edit tasks. Click the File tab and, from the Backstage view, click New. From the Available Templates (see Figure 3.1), click a template in the New from Existing group or you can search at the Office Online Web site for templates by clicking the arrow button beside the Search Microsoft Office Online for templates box.

Select a template and click the Create button. If you select any template other than Blank Project, Project displays a new project that contains tasks relevant to the title of the template you selected. You can use this project as a starting point for your project and modify it as needed.

Note

You might need your Project 2010 CD to install a template.

Opening projects

You can open projects by clicking the File button and, from the Backstage view, click Recent. Project displays a list of the last 17 projects you opened (see Figure 3.2); click one and Project displays it on-screen.
Tip
You can change the number of files that Project displays in the Recent list. Click the File tab and, from Backstage view, click Options. In the Project Options dialog box that appears, click the Advanced tab. In the Display section, change the number shown in the Show this Number of Recent Documents box.

If the project you want to open doesn’t appear in the Recent Projects list, you can click Open in Backstage view. In this case, Project displays the Open dialog box shown in Figure 3.3.

Tip
If you want to open a file created in Project 2007 or earlier, you might need to set permissions. Click the File tab and, from Backstage view, click Options. In the Project Options dialog box, click the Trust Center tab and then click the Trust Center Settings button. In the Trust Center dialog box that appears, click Legacy Formats and select one of these options: (1) Prompt When Loading Files with Legacy or Non-default File Format or (2) Allow Loading Files with Legacy or Non-default File Formats. Click OK twice to save your choice.

FIGURE 3.1
Select a template on which to base your project.
Part II: Getting Your Project Going

**FIGURE 3.2**
Click Recent in the Backstage view to see a list of the last 17 projects you opened.

![Figure 3.2](image1.png)

**FIGURE 3.3**
Use the Open dialog box to navigate to the folder where you store projects and select a project to open.

![Figure 3.3](image2.png)
Establishing Basic Project Information

Use the Project Information dialog box (shown in Figure 3.4) to supply basic information about the new project you want to set up. If this box doesn’t appear automatically, click the Project tab and, in the Properties group, click the Project Information button to display the dialog box.

FIGURE 3.4
The Project Information dialog box tracks basic information about each project.

Tip
You can make the Project Information dialog box appear automatically whenever you start a new project. Click the File tab and, in Backstage view, click Options. In the Project Options dialog box that appears, click the Advanced tab. In the General section, place a check in the Prompt for Project Info for New Projects box.

You can enter the following eight pieces of information in the Project Information dialog box:

- **Start Date**: If you set a start date for the project, all tasks begin on that date until you assign timing or dependencies to them.

- **Finish Date**: If you know your project’s deadline, you can enter it here and then work backward to schedule your project. You must change the setting in the Schedule from field to make this option available.

- **Schedule From**: You can build schedules from completion to start by setting this field to Project Finish Date. Alternatively, you can build your schedule from the start date forward by accepting the default setting, Project Start Date.

- **Current Date**: Project uses your computer’s current date setting for the default entry in this field. To use a different date, change the date in this field. You can adjust this setting to generate reports that provide information on your project as of a certain date or to go back and track your project’s progress from an earlier date.
Part II: Getting Your Project Going

- **Status Date:** Typically you set the Status Date after you set a baseline for your project and you begin tracking actual progress; that’s because often the day you record the progress is not the day on which it occurred. The Status Date field sets the date used in the earned-value calculations and identifies the complete-through date in the Update Project dialog box. The Status Date also enables Project to place progress lines in your project. If you leave the Status Date set at NA, Project sets the Status Date to your computer’s current date setting.

- **Calendar:** You can select the calendar on which to base your schedule. The Standard calendar is the default — it schedules work eight hours a day, five days a week.

- **Priority:** You can establish a priority for each project in addition to setting priorities for tasks. For priorities, Project uses a numerical value between 1 and 1,000. The project level priority plays a role when you use shared resources across multiple projects. Setting a project priority helps you to better control how resource leveling adjusts tasks when you share resources across projects.

**Note**

Leveling is a technique you can use to smooth out the use of resources so you use them most efficiently. Leveling is particularly useful when your resources are overallocated; Project can help you reallocate your resources’ efforts and potentially eliminate conflicts.

**Cross-Reference**

For more information on resource leveling, see Chapter 11.

- **Enterprise Custom Fields:** If your organization uses Project Server, you may need to assign values to project-level custom fields or outline any codes you’re using that are defined in the Project Server database. You see an asterisk (*) next to any required custom field or outline code.

Make a choice in the Schedule From field and then enter either a start or finish date — only one is available to you, depending on the choice that you’ve made in the Schedule From field. If you schedule from the project start date, Project defaults the constraint type for all new tasks to start As Soon As Possible (ASAP). And, as you would expect, if you schedule from the project finish date, Project defaults the constraint type for All new tasks to start As Late As Possible (ALAP). To enter one of these dates, click the down arrow next to the text box. (The arrow is not available if the Schedule From field isn’t set for that choice.) Select a date from the pop-up calendar, as shown in Figure 3.5.

**Caution**

If you decide to schedule backward from the finish date, Project can’t use tools such as resource leveling to resolve conflicts in your schedule.

You can change the project’s start date during the planning phase, trying out alternative what-if scenarios by modifying this field. As you build your tasks going forward, if you use automatic scheduling, Project calculates the project finish date as dictated by the length of your tasks and their timing relationships. Later in this chapter, you can read more about automatic and manual scheduling.
FIGURE 3.5
Use the arrow keys at the top of this calendar to choose other months.

Tip
If you have already begun the project, you can set the start date to a date in the past to accurately reflect the real start date.

If you know the date by which something must be completed (as with the annual meeting project in the earlier example, or a Christmas party that must happen on December 25), you can schedule tasks by moving backward from the finish date. When you do this and use automatic scheduling, Project builds the tasks going back in time. You may be surprised when Project generates a schedule telling you that you should have started three weeks earlier to finish on time. In that case, you can either add resources to get the work done faster or reduce the scope of the project.

Cross-Reference
In Chapters 10 and 11, you can read about techniques that can help you resolve scheduling and resource problems.

When beginning a new schedule, you typically accept the default settings for Current date and Status date. After your project is under way, changing these default settings affects project tracking — as well as the material that is generated in project reports.

For now, you can keep all the default settings (that is, scheduling from the start of the project, having the current date be today, and starting the project today, as well as basing your schedule on the standard calendar). Click OK to close the Project Information dialog box.
Part II: Getting Your Project Going

Looking at Project Calendars

The Project Information dialog box enables you to set the basic parameters of the project’s timing. Those parameters — and the information you’re about to enter for specific tasks — are based on the Standard calendar, also called the base calendar because it serves as the basis for the calendar-scheduling calculations Project makes.

You can create a Standard calendar for each group of resources in your project. For example, if the plant employees work a nine-hour day from 6:00 a.m. to 3:00 p.m., and the office employees work an eight-hour day from 8:00 a.m. to 5:00 p.m., you can create two calendars. When you assign one day of an office employee’s time, Project understands it to be an eight-hour day. In the Project Information dialog box, you designate whether you want your project to use a standard, 24-hour, or night-shift calendar for most of your work assignments.

Note
If you’re using Project Standard, the preceding information is absolutely true. If you’re using Project Professional, it’s almost all true. When using Project Professional, you can create your own calendars (for both projects and tasks) if you’re working offline and storing the project locally (that is, not in the Project Server database). If you store the project in the Project Server database, you can create calendars only if the administrator has given you the rights to do so.

Project also supports resource calendars and task calendars you can use when a resource’s calendar or a task’s calendar don’t follow the Standard calendar for the project. Resource and task calendars work well for resources or tasks in your project with work hours that differ from the rest of the resources or tasks.

Cross-Reference
You find out more about task calendars in Chapter 4 and more about resource calendars in Chapter 5.

Setting calendar options

Project makes default assumptions about certain items that form the basis of the default project calendar. For example, Project assumes that the default week contains five working days and 40 working hours. Project uses this calendar for resources unless you assign a different calendar to them. You can see the assumptions that Project uses when you click Schedule in the Project Options dialog box.

Note
These options do not affect scheduling. The options you see in this dialog box show you the defaults that Project uses to convert durations into corresponding time amounts. For example, if you enter 1mo for a task’s duration, Project assumes you’re allotting the equivalent of 20 days for that task.

To view the default calendar options, click the File tab and, from Backstage view, click Project Options. Click Schedule in the Project Options dialog box (see Figure 3.6).
Chapter 3: Creating a New Project

**Caution**
Any changes you make to these options apply to the current schedule only. To save your current changes and make them apply to all new project schedules, open the Calendar Options for this Project list and select All New Projects.

You can select any day of the week as your start day. For example, if you run a restaurant that closes on Sundays and Mondays, you might want to designate a work week of Tuesday through Saturday. In that case, you would set the Week Starts On field to Tuesday.

If your company uses a fiscal year other than the calendar year (January through December), you can set the Fiscal Year Starts In option. This setting is especially useful when you generate reports that show costs per quarter or year.

The other five Calendar options enable you to designate specific start and end times for each day, the number of hours in a day and in a week, and the number of days in a month. For example, you can set the work day to start at 9:00 a.m. and end at 6:00 p.m., assign 9 hours to your work day (no lunch for you!), and end up with a 45-hour week.

**FIGURE 3.6**
By reviewing the Calendar settings in the Project Options dialog box, you ensure that you and Project are speaking the same language when you enter task-duration information.
Part II: Getting Your Project Going

Setting schedule options

You also can modify the way in which Project enters task information. In the Project Options dialog box (if it isn’t open, click the File tab and, in the Backstage view, click Options), click Schedule and then use the options shown in Figure 3.7 to change the default settings for entering tasks. You determine

- Whether Project shows scheduling messages that give you guidance about scheduling conflicts you might accidentally impose (select or deselect the Show Scheduling Messages check box).
- Whether Project displays assignment units as percentages or decimals. (In Figure 3.7, I’ve selected percentage.)
- Whether Project enters tasks without dates, uses the project Start Date, or uses the current date.
- The default unit of time for entering task durations (the default is days) and work time (hours).

When setting the last two options, suppose you’re working on a five-year project in which most tasks run for months, not days. You might want to change the default setting for the Duration Is Entered In field. If you prefer to have any new tasks begin no earlier than the current date, you can adjust the setting for New tasks. As you gain experience with entering information, you’ll find ways to customize Project to match your work style.

**FIGURE 3.7**

The Schedule tab is where you modify the default settings for entering tasks.
You also can use the check boxes to set Project behavior concerning tasks; Chapter 4 explains many of the concepts associated with the task behavior referenced in these options:

- **New Tasks Are Effort Driven**: If you check this box, Project schedules new tasks so that the work on the task remains constant as you add or remove assignments. See Chapter 4 for more information on effort-driven tasks, but, in general, assigning additional resources to an effort-driven task shortens the task duration.

- **Autolink Inserted or Moved Tasks**: If you check this box, Project automatically reestablishes a dependency between contiguous tasks that you move or insert.

- **Split In-Progress Tasks**: If you check this box, you allow Project to reschedule remaining duration and work when a task slips or when you report progress on a task ahead of its schedule. In this case, Project creates a split task — a task whose schedule is interrupted. Checking this box helps ensure that the progress you record appears when it actually takes place; if you remove the check from this box, the progress information you enter appears on the originally scheduled dates.

- **Tasks Can Be Manually Scheduled**: If you check this box, you have the option to schedule a task manually which gives you control over its dates or let Project schedule it automatically for you, according to the dependencies and constraints you’ve specified.

**New Feature**

*The Task Mode field, which enables you to choose between automatic and manual scheduling for a task, is new to Project 2010. You can read more about it later in this chapter.*

- **Update Manually Scheduled Tasks When Editing Links**: If you check this box, Project will make appropriate changes to manually scheduled tasks if you edit links that affect them.

- **Tasks Will Always Honor Their Constraint Dates**: If you check this box, Project schedules tasks according to their constraint dates and doesn’t move them. See Chapter 4 for more information on constraints.

- **Show That Scheduled Tasks Have Estimated Durations**: If you check this box, Project displays a question mark (?) after the duration unit of any task for which you set a tentative duration rather than one that you want to establish firmly. The question mark provides a visual clue that the duration is only an estimate.

- **New Scheduled Tasks Have Estimated Durations**: If you check this box and enter a scheduled task, Project displays a question mark, indicating an estimated duration.

- **Tasks Can Be Made Inactive**: In Project Professional, if you check this box, you can opt to make a task inactive as necessary. Inactive tasks remain in the schedule but do not affect it.

**New Feature**

*Creating inactive tasks is a new feature in Project Professional 2010. You can read more about them in Chapter 10.*
Part II: Getting Your Project Going

- **Keep Task on Nearest Working Day When Changing to Automatically Scheduled Mode:** If you check this box and then change a manually scheduled task to an automatically scheduled task, Project schedules the task on the working day closest to the manually established date.

- **Show Task Schedule Warnings:** If you check this box, Project uses a red squiggly underline to identify tasks that might need to happen later than you expect.

- **Show Task Schedule Suggestions:** If you check this box, Project uses a green squiggly underline to identify tasks that might be able to happen sooner than you expect.

**New Feature**

Task schedule warnings and suggestions are new to Project 2010.

When you are satisfied with the settings on the Schedule tab, click OK to close the Project Options dialog box.

**Creating a new calendar**

The Standard calendar might not work for your project under all circumstances. For example, suppose you run a print shop and each project you complete requires you to use the printing press, but the press requires cleaning and maintenance each week for two hours on Thursday afternoon. To make sure that each printing project takes into consideration the scheduled maintenance requirement of the printing press, you can create a Press calendar that covers the need to shut down the press for cleaning and maintenance. Then you can assign the Press calendar to the Press Time task that you create for each project.

**Note**

As previously mentioned, if you’re using Project Standard, everything you’re about to read works automatically. However, if you’re using Project Professional, you can create your own calendars (for both projects and tasks) if you’re working offline and storing the project locally (not in the Project Server database). If you store the project in the Project Server database, you can create calendars only if the administrator has given you the rights to do so. Also, note that having the privilege to create calendars still doesn’t permit you to change the Standard calendar.

To create a new, project-wide calendar, click the Project tab and, in the Properties group, click Change Working Time to display the Change Working Time dialog box shown in Figure 3.8. The Legend panel on the left side of the dialog box identifies Working, Nonworking, and Edited Working Hours, as well as exception days and nondefault work weeks. If other calendars exist, you see them listed in the For Calendar list box at the top of the dialog box.

**Tip**

Although you can make changes to the Standard calendar, I suggest that you make a copy of the Standard calendar rather than modify it. That way, you can always use the original Standard calendar if you need it.
FIGURE 3.8
By default, Project displays the settings for Standard (Project Calendar) in the Change Working Time dialog box.

You can create a custom calendar by clicking the Create New Calendar button. Project then displays the Create New Base Calendar dialog box (see Figure 3.9) and suggests the name “Copy of Standard.”

FIGURE 3.9
From the Create New Base Calendar dialog box, you can create a copy of an existing calendar or you can create a new Standard calendar.

To model your calendar on an existing calendar, select the existing calendar from the Make a Copy Of drop-down box. Provide a name for the new calendar in the Name box (as I did in Figure 3.9) and click OK to create the new calendar.
Part II: Getting Your Project Going

Adjusting the calendar

You can define the work week or create exceptions to the Standard calendar or any other calendar using the tabs at the bottom of the Change Working Time dialog box. To accommodate the maintenance time needed for the printing press, you would modify the work week for the printing press by following these steps:

1. Click the Work Weeks tab.
2. Click the [Default] work week already defined for the calendar by Project (see Figure 3.10).
3. Click Details. Project displays the Details dialog box (see Figure 3.11).
4. Select the day you want to change from the Select Day(s) list on the left side of the dialog box.
5. On the right side of the box, select the appropriate option; for this example, I chose Set Day(s) to These Specific Working Times.
6. In the grid section, define the working time for the selected day.
7. Click OK. Project redisplay the Change Working Time dialog box.

FIGURE 3.10

To modify the default work week, select [Default] on the Work Weeks tab.
FIGURE 3.11
Use this dialog box to redefine a work week.

When you change the work week, the change you make is not considered an exception; instead, it's considered the new normal work week. You won't see any changes to the calendar showing up in the Change Working Time dialog box. You can, however, identify the working time for any day by clicking that day on the calendar; the working time appears to the right.

Suppose, however, that your child has swimming lessons every Wednesday afternoon during the month of July and you, as the owner of the business, have decided to close the shop and take your child to swimming lessons because business is slow in the summer anyway. To set up a working time exception like this one, follow these steps:

1. Click the Exceptions tab in the Change Working Time dialog box.
2. In the Name column, type a name that helps you remember the purpose of the exception.
3. In the Start column, select the date on which the exception starts.
4. In the Finish column, select the date on which the exception ends. Project sets every day between the starting and ending dates as an exception on the calendar, and the Details button and the Delete button become available (see Figure 3.12).
5. Click the Details button. Project displays the Details For dialog box shown in Figure 3.13.
6. In the top section of the dialog box, click the Working Times option button and then set the working times; in this example, I set the working time from 8:00 a.m. to 1:00 p.m.
7. To repeat this working time pattern every Wednesday, click Weekly in the Recurrence pattern section and check the Wednesday check box.
8. In the Range of Recurrence section, set the starting and ending dates for the working time exception using the dates you supplied in Steps 3 and 4. You can change these dates if you want.
9. Click OK. When Project redisplays the Change Working Time dialog box, every Wednesday between the beginning and ending dates you specified appears as an exception on the calendar (see Figure 3.14).
Part II: Getting Your Project Going

**FIGURE 3.12**

To set up a working time exception, type a name for the exception and set dates.

**FIGURE 3.13**

Use this dialog box to define the working time exception.
Chapter 3: Creating a New Project

Working with Tasks

Tasks are the heart and soul of every project. You’ll spend much of your time in Project adding and modifying tasks. In this section, you get started creating a project by entering major tasks into a project schedule. Then you refine the major tasks by adding detail tasks that help you accomplish the major tasks — and, in the process, you build an outline of your project.

In this section, you also explore adding tasks to the timeline and how the use of manually scheduled tasks compares with using automatically scheduled tasks.

Note

Project 2010 contains a new task mode that allows you to manually schedule tasks; in the past, the only task mode available was to allow Project to automatically calculate Start Date, Finish Date, Work and Duration values for a task based on dependencies, constraints, calendars, and other factors. Because the power of project management software lies mostly in its ability to calculate your project’s schedule and cost, I make the assumption throughout this book that you use Project 2010 predominantly in the Auto Schedule task mode; that’s where Project’s behavior is much like that of its predecessors. Later in this chapter, I show you an example of using the Manually Schedule task mode.
Part II: Getting Your Project Going

**Entering tasks**

To begin building a project, enter the major steps to reach your goal in roughly the same order that you expect them to occur. (Don’t worry if you’re not quite accurate about the sequence of events; Project makes it easy to reorganize tasks in your schedule at any time.) For the sample project (organizing a corporate annual meeting), follow these steps to create your first task — booking the meeting space:

1. Click the Task Name column in the first row of the Gantt table.
2. Type Book Meeting Space. The text appears in the cell.
3. Press Enter to accept the text.

Information begins to appear in your schedule. Project lists the task name in the Task Name column and makes a corresponding entry in the Duration column. The question mark in the Duration column represents an estimated duration. According to the Start column, the task begins today, and a task bar in the chart portion of the Gantt Chart view reflects the one-day duration of the task graphically. And, as you work, Project highlights any change you make that affects the schedule; because I added a task, the Duration and Start Date appear highlighted in Figure 3.15.

**FIGURE 3.15**

Project highlights the duration and dates of any changes you make that affect the project schedule.
Cross-Reference
Chapter 4 contains more information about estimated durations.

New Feature
The Task Mode column displays an image that identifies whether a task is being scheduled automatically or manually. Figure 3.15 shows an automatically scheduled task.

You can use the scroll bar located at the bottom of the Gantt table to move to the right and view the Finish Date entry. Because this is a one-day task, it will be completed by the end of the day.

Tip
You also can drag the bar that divides the Gantt table from the Gantt Chart to expand the visible area of the Gantt table.

In the second row in the Task Name column and enter Schedule Speakers as the next task. Then enter the following tasks on the next four rows: Arrange for Audio/Visual Equipment, Order Food, Send Invitations, and Mail Annual Reports. Your schedule should now look like that shown in Figure 3.16.

FIGURE 3.16
Note that each task is the same length by default, and each begins on the project’s start date.
Note
If you make a mistake, you can click the Undo button on the Quick Access Toolbar in the upper-left corner of the screen. Each time you click the Undo button, Project 2010 displays an earlier version of your project. You can click the Undo button multiple times to undo multiple prior actions.

Adding detail tasks
After you enter the major tasks in your project, you can begin to flesh out the details by adding subordinate tasks, also referred to as subtasks or detail tasks to each major task. When you add detail tasks, the upper-level task becomes a summary task. Summary tasks and detail tasks provide an easy-to-apply outline structure for your schedule, and summary tasks often represent phases of projects.

Project’s outline approach also enables you to display and print your project information with various levels of detail. For example, with only summary tasks showing, you see a higher-level overview of the project that you may want to present to management. On the other hand, you can reveal the details of only one or two phases of a project so you can discuss those tasks with the people who will be performing them. The outline structure gives you a lot of flexibility in working with your schedule.

When you insert a new task, it appears above the currently selected task. Begin by adding detail tasks under the Book meeting space task. Follow these steps to insert a new detail task:

1. Click the Schedule Speakers task.
2. Click the Task tab and, in the Insert group, click the top portion of the Task button. Row 2 displays the beginning of a new task, with a prompt for a task name appearing in the Task Name column. All the other tasks move down one row (see Figure 3.17).

Note
If you click a blank row in the project and then click the top of the Task button, Project adds the new row below the last completed row.

3. Type Request purchase order and press Enter to accept the new task.
4. To indent the detail task, select it, click the Task tab and, in the Schedule group, click the Indent button (see Figure 3.18). The task above the selected task — Book Meeting Space in this example — becomes a summary task and appears in boldface type. The selected task appears indented below the summary task.

Notice that the summary task (Book Meeting Space) now displays a black bar on the chart portion of the Gantt Chart view, with a down arrow shape marking its beginning and end. When you work with automatically scheduled tasks and a task becomes a summary task (that is, when it contains detail tasks), the timing of the summary task reflects the total amount of time required to complete all of its detail tasks.
FIGURE 3.17
When you insert a task, Project prompts you to type a name for the new task.

Note
If a task has a duration assigned to it and you make it into a summary task, the timing of the detail tasks overrides the assigned duration. If you change the timing of a detail task, the summary task duration changes to reflect the change.

New Feature
Along the way, you might discover that you need a new major heading instead of a new detail task. No problem — and accomplished more easily than in earlier versions of Project. Select the task you want to appear below the new summary task. Then click the Task tab and, in the Insert group, click the Insert Summary Task button. Project inserts the summary task above the selected task, indents the selected task, and prompts you for a name for the summary task.
You can add other detail tasks by following these steps:

1. Click the Schedule Speakers task.
2. Press the Insert key on your keyboard (which is a shortcut for clicking the Task button on the Ribbon).
   A new blank row appears.
3. Type **Select Room** and press Enter to accept the new task.
   The new task uses the same level of indentation as the task above it.
5. Type **Confirm Space** and press Enter to accept the new task.
   The new task uses the same level of indentation as the task above it.
6. Press Insert.
7. Type **Order Flowers** and press Enter to accept the new task.
Each of these new tasks indents to the subordinate level. However, the third new task — Order Flowers — is not a detail task of the Book Meeting Space summary task. To move the task higher in the outline hierarchy, simply click in the Task Name column of that task (or any column of the task) to select it and, on the Task tab in the Tasks group, click the Outdent button (which does the opposite of indenting as it promotes the task to a higher level).

**Note**

Project won’t use any Change Highlighting, a feature that highlights all tasks affected by changes you make to any single task, when you outdent a task if outdenting doesn’t affect any task dates or durations.

Your schedule now looks like the schedule shown in Figure 3.19. Adding details is as simple as inserting new tasks wherever you want them and then moving the tasks in or out in the outline structure.

You can come back later and add more information to your tasks; explore the kinds of information you can add in Chapter 4.

**FIGURE 3.19**

The outline structure enables you to see summary tasks and subtasks as manageable chunks of work.
Part II: Getting Your Project Going

New Feature
If you’re using Project Professional and you find you don’t need a particular task in your project at some point, you can make it inactive instead of deleting it. (See Chapter 10 for details on using inactive tasks.) ■

Adding tasks to the timeline
You can use the Timeline that appears above the view area to present an overview picture of a project. Project doesn’t display all tasks on the Timeline by default; instead, Project lets you identify the tasks to include.

Tip
If the Timeline doesn’t appear between the bottom of the Ribbon and the top of the View area, click the View tab and, in the Split View group, place a check in the Timeline box. ■

You can easily add a task to the Timeline using any of the following techniques:

- Click the task to select it; then, on the Task tab, in the Properties group, click the Add Task to Timeline button.
- Right-click the task and choose Add to Timeline.
- Double-click the task to display the Task Information dialog box; then, on the General tab, place a check in the Display on Timeline check box.

In Figure 3.20, I’ve added the summary tasks to the Timeline. Using the scroll bars below the right portion of the Gantt Chart view, I can see different time periods of my project, and the information on the Timeline changes to match whatever dates I view.

Tip
If you decide later that you don’t want a particular task to appear on the Timeline, right-click that on the Timeline and choose Remove from Timeline. ■

In addition to displaying the Timeline in Project, you can copy it in a couple of different ways and then paste it into other Office programs. At the top of the Timeline, just below the Ribbon, you’ll see a light blue bar; right-click that bar, point at Copy Timeline and click For E-mail, For Presentation, or Full Size (see Figure 3.21). Each copy produces a slightly different size of the Timeline that you can paste into a file in another Office program (such as a Word document, a PowerPoint slide, or an Outlook e-mail message).

Cross-Reference
You also can display the Timeline as a view without any other view; see Chapter 6 for details. ■
Manual or automatic scheduling?

In Project 2010 contains a new task mode that allows you to manually schedule tasks. Previous versions of Project offered only one task mode: You had to let Project to calculate Start Date, Finish Date, Work, and Duration values automatically for each task based on their dependencies, constraints, calendars, and other factors. The power of project management software lies in its ability to calculate your project’s schedule and cost; manual scheduling is a useful, but subsidiary, feature. That’s why, throughout this book, I assume you’re using Project 2010 primarily in Auto Schedule task mode, where Project behaves much like its predecessors.

You might find manually scheduled tasks useful when you first start a project. When you add manually scheduled tasks to a project, you don’t need to supply a duration, a start date, or a finish date; you can simply create a list. You can use manually scheduled tasks to work on your project’s outline structure, creating summary tasks and indenting and outdenting as needed. You also might find manually scheduled tasks useful when setting up tasks in a project with a very long timeline; you can use automatically scheduled tasks for the early part of the project and use manually scheduled tasks for the later portion of the project, when timeframes are not as clear.
Part II: Getting Your Project Going

**Note**

For you Project Server users, be aware that manually scheduled tasks cannot be updated by team members in the same ways that automatically scheduled tasks can be updated. For example, team members cannot update status by supplying number of hours worked per day or week. Also important is that manually scheduled tasks cannot be updated in PWA in the same ways as automatically scheduled tasks. A resource you assign to a manually scheduled task cannot update status in a timescaled way (number of hours per day or week); only total Actual work or % complete updates are available.

Project enables you to do much more with manually scheduled tasks; for example, you can set dependencies between manually scheduled tasks and you can, if you want, supply duration or date information. However, it’s important to remember that manual scheduling gives you complete control over your tasks; Project has no control over manually scheduled tasks.

**Caution**

You can easily change a manually scheduled task to an automatically scheduled task — and vice versa. However, depending on how your options are set, switching back and forth can introduce constraints you didn’t intend. If you use manually scheduled tasks to set up dependencies, you might unintentionally introduce scheduling conflicts. Exercise care when using manually scheduled tasks; they might produce a schedule that won’t work — and Project won’t adjust manually scheduled tasks to make your schedule functional.
Creating manually scheduled tasks

Suppose you want to start a new project and you’re at the point where you want to list all the tasks without worrying about their durations, start dates or end dates. You can set the default scheduling mode for the current project by using the Task Mode button on the Status bar.

At the left edge of the Status Bar, the Task Mode button identifies how Project treats new tasks in the current project for scheduling purposes. Click the button (see Figure 3.22) to select the scheduling mode you’d like to use by default in the current project. The out-of-the-box default is Manually Scheduled.
Part II: Getting Your Project Going

**Note**
The choice you make affects only new tasks; it doesn’t affect any tasks already in the project.

Next, enter manually scheduled tasks the same way that you enter automatically scheduled tasks:

- Click in the Task Name column on the row where you want to enter a task, type a name for the task, and press Enter. Or,
- Click the row on which you want to enter a task, click the Task tab, and then click the top of the Task button in the Insert group.

Compare Figure 3.23 with Figure 3.24. The two projects contain the same tasks, but I set up Figure 3.23 using manually scheduled tasks and Figure 3.24 using automatically scheduled tasks.

**FIGURE 3.23**
A project that uses manually scheduled tasks.
FIGURE 3.24
A project that uses automatically scheduled tasks.

Note that the image in the Task Mode column in Figure 3.23 is different from the image shown in Figure 3.24.

In addition, in Figure 3.23, no bars appear in the chart portion of the Gantt Chart view; the bars represent duration and start and finish dates — but because I didn’t supply that information, Project has no information to use to create any bars for the chart. In Figure 3.24, Project assigned an estimated duration of 1 day to each task and supplied bars in the chart portion of the view.

In Figure 3.25, I indented the tasks on Rows 2, 3, and 4 in the project that uses manually scheduled tasks. Project converts the Book Meeting Space summary task to an automatically scheduled task, assigns an estimated duration of 1 day to the task, and displays a summary task bar beside the summary task that reflects the estimated duration. Note, however, that Project doesn’t make any changes to the other manually scheduled tasks.
Part II: Getting Your Project Going

Switching a task’s scheduling mode

If you want to use a mixture of manually scheduled and automatically scheduled tasks in your project, select the Task Mode (using the Status Bar button) for the majority of tasks in your project. Then you can change the scheduling mode for an individual task in one of two ways:

- You can click in the Task Mode column and select the appropriate mode for that task (see Figure 3.26).
- You can select the task by clicking in the Task Name column and then using the Manually Schedule and Auto Schedule buttons in the Tasks group on the Task tab to set the task mode for the selected task.

Caution

In the Project Options dialog box, placing a check next to Keep Task On Nearest Working Day when Changing to Automatically Scheduled Mode can cause Project to create constraints if you change a manually scheduled task to an automatically scheduled task.
Change the scheduling mode of a task using either the Task Mode column or the buttons in the Schedule group on the Ribbon.

These buttons are available when you don’t open the list in the Task Mode column.

Setting the default scheduling mode

If you expect to use one scheduling mode more than the other for all new projects, you can set that mode as the default scheduling mode in the Project Options dialog box. Follow these steps:

1. Click the File tab.
2. In the Backstage view, click Options to display the Project Options dialog box.
3. Click Schedule on the left.
4. Open the list box beside Scheduling Options in This Project and select All New Projects.
5. To set the default scheduling mode, open the New Tasks Created list box (see Figure 3.27) and select Manually Scheduled or Auto Scheduled.
6. Click OK.
7. Repeat these steps for the current project (that is, in Step 4, select the current project instead of selecting All New Projects).
Part II: Getting Your Project Going

FIGURE 3.27
The New Tasks Created list box controls whether Project uses manual or automatic scheduling by default.

Saving Project Files

Of course, you should always save your work frequently. Information centralized in a Project file is often mission-critical, which makes frequent saving even more important. When saving Project files, you have the option of setting up protection for them. You can also save your files as templates — files on which you can base other schedules.

Saving files

To save a Project file for the first time, click the Save tool on the QAT or click the File tab and, in the Backstage view, click Save. In the Save As dialog box that appears, specify the name of the file, where to save the file, and what format you want to use (see Figure 3.28).

In the File Name box, type a name for the file. Use the options in the left pane to navigate to the folder in which to save the file.
Chapter 3: Creating a New Project

Note
Project 2003, Project, 2002, and Project 2000 all use the same file format, but Project 2007 uses a different format from its predecessors, and Project 2010 uses yet another different file format. If you need to share your files with users of earlier versions of Project, you can save your file using the file format for Project 2000 – 2003. Any features or formatting exclusive to Project 2010 will be lost. Also note that Project 2007 and 2010 cannot save to the Project 98 file format.

FIGURE 3.28
Use the Save As dialog box to tell Project where to save a file and what format to use.

By default, Project saves files in Project 2010 format with the extension .mpp. To save a file in a different format, such as a Project 2007 file (also .mpp) or a Project 2000 – 2003 file (also .mpp), you can select that format in the Save as Type drop-down list. After you enter a name for your file and designate its location and type, click the Save button to save the file.

Note
After you save a project for the first time, you can simply click the Save button to save the file; Project doesn’t display this dialog box. If you want to change a setting or save the file with a new name, click the File tab and — in Backstage view — click Save As to display this dialog box again.
Part II: Getting Your Project Going

Saving files as templates

Here’s another place where manually scheduled tasks might come in handy: You can use them to set up a template of a project that you perform often. In a template, you set up the tasks for the project and create the project outline. The template then forms a great starting place for others who use it to manage a project. A template file saves all the settings that you may have made for a particular project, such as formatting, commonly performed tasks, and calendar choices. Keeping template files on hand can save your coworkers (and you) from having to reinvent the wheel each time that you want to build a similar project.

To save a project file as a template, use the Save As dialog box (shown in the preceding section); in the Save as type list, select Template (*.mpt). Project prompts you to remove baselines, actual values, resource rates, fixed costs, and any information indicating whether tasks have been published to Project Server. As needed, check these boxes — and then click Save.

To create a new schedule based on a template, click the File tab and, from the Back Stage view, click New. Click My Templates to view a list of templates you’ve created, select one, and click OK. Project opens a new file that contains all the information you saved in your template. When you save your new project, be sure to supply a new name and select Project from the Save As Type list.

Protecting files

Some projects are as “top secret” as an FBI file. In such a case, some people within the organization — and certainly people from outside the organization — should not have access to project details. If your projects fit this mold, you need a way to keep your Project files secure from prying eyes. You can set a measure of security for Project 2010 files; click the File tab and choose Save As from the Backstage view to display the Save As dialog box. Click the Tools button and choose General Options to display the Save Options dialog box, as shown in Figure 3.29.

Caution

Don’t use your phone extension, birthday, spouse’s name, or similar quick choice as a password — such passwords are much too easy to break!

Assign a password in the Protection password box to safeguard the file from being opened by anyone who doesn’t know the password. If you assign a Write Reservation password, on the other hand, anyone can open the file without a password, but as a read-only file (that is, anyone can look, but only those who know the Write Reservation password can make changes to the file). Finally, if you check the Read-Only recommended option, Project displays a message recommending that anyone opening the file not make changes to it. However, this choice doesn’t prevent someone from making changes.
Tip
What kind of passwords should you use? Consider two factors: You must be able to remember the password, and you must make it something that the average person can’t guess. (No password is perfect; if someone really wants to break into your files, he or she will.) Try using passwords such as an address or phone number that you had as a child — information that you remember but others are not likely to know. The longer the password, the harder it is to break.

FIGURE 3.29
The Save Options dialog box.

Caution
Both the Protection password and Write reservation password are case-sensitive. If you assign JoeS as a password, you can’t open the file if you enter joes.

Closing Project
When you’re finished working in Project, you can save your files as described previously and then use one of the following methods to close the program:

- Click the Close button in the upper-right corner of the Project window.
- Click the File tab and, in the Backstage view, click Exit.

If you haven’t saved any open files, Project prompts you to do so.
Part II: Getting Your Project Going

Working with a Project Outline

After you build a project outline, reorganizing the order of individual tasks is easy. You also can manipulate the outline to show either more or less detail about your project. Outlining features work the same way in many software products. For example, Microsoft Word, PowerPoint, and Project all have the same outlining tools and features. In Project, you can move, copy, hide, and display tasks.

Adjusting tasks in an outline

To illustrate adjusting tasks in the outline, I use the project shown in Figure 3.30.

To move tasks in an outline, you can cut and paste (as in the following Steps 1 through 4) or you can drag and drop (as in the following Steps 5 through 7). You also can change the relative position of tasks in the hierarchy of the outline by promoting or demoting them (outdenting or indenting). In Step 8, you see an example of demoting a task.

To move tasks, you must first select them. Use any of the following techniques to select tasks:

Tip
You can select a task by clicking its Gantt bar.
Chapter 3: Creating a New Project

- To select a single task, click its ID number. As you hover the mouse pointer over an ID number, the pointer changes to a right-pointing arrow.
- To select several contiguous tasks, select the first task. Then hold down Shift and click the last task that you want to select.
- To select several noncontiguous tasks, hold down Ctrl as you click the ID numbers of the tasks that you want to select.

Moving summary tasks and detail tasks can be a little tricky. Although you can move tasks wherever you like, it's important to remember that when you move a summary task, its detail tasks move with it. Furthermore, if you move a task at the highest level of the outline to a new location just below a summary task that has detail tasks, Project demotes the task that you move. Similarly, if you move a detail task so it appears below a task at the highest level of the outline, Project promotes the detail task that you move. To get a feel for this behavior, try the following steps:

**Note**

To move a summary task only — without moving any of its detail tasks — you must first promote all its detail tasks to the same level as the summary task.

1. Click the ID number in the leftmost column for the task you want to move (in my example, it's Task 5, the Order Flowers task). Project highlights (selects) the entire row.
2. Click the Task tab and, in the Clipboard group, click the Cut tool. The task disappears from the project.
3. Click the Gantt bar for the task that should appear below the task you're moving. In my example, I click Task 8, the Send Invitations task. Project selects the row.
4. On the Task tab in the Clipboard group, click the top of the Paste button. The task you selected in Step 1 (Order Flowers) appears selected in its new location above the Send Invitations task (see Figure 3.31).
5. Click the ID number of the next task to move; for this example, I clicked Task 2, the Request Purchase Order task.
6. Move the mouse pointer over the ID number of the selected task; the pointer changes to a four-way arrow.
7. Press and hold down the left mouse button while you drag the task to its new position; in this example, I dragged the Request Purchase Order task below the Order Food task. A horizontal gray line appears on-screen, indicating the new proposed position as you drag (see Figure 3.32). When you release the mouse button, Project moves the task and promotes the Request Purchase Order task in accordance with its new position in the outline.
8. To demote the Request Purchase Order task, click either the ID number or the task name to select the task, and then click the Task tab and, in the Tasks group, click the Indent button.

**Tip**

You can promote or demote tasks by dragging. Dragging a task to the left promotes the task in the project outline. Similarly, dragging a task to the right demotes the task. When you promote or demote tasks, you see the same gray line (only it’s vertical) that you see when you move tasks up or down in the outline.
Note
You also can promote or demote by dragging. Move the mouse pointer over the first few letters of the subtask's name until the pointer becomes a double arrow. Then drag the task to the left or right.

Your schedule now has two tasks with detail tasks beneath them (see Figure 3.33).

Copying tasks
Copying tasks also is simple to do and can come in handy while building a project outline. For example, suppose you were entering tasks in a project to test various versions of a compound to see which works best as a fixative. You may repeat the same series of tasks (Obtain Compound Sample, Test in Various Environments, Write Up Test Results, Analyze Results, and so on) several times. Instead of typing those tasks 10 or 20 times, you can save time by copying them.

Warning
While you run no risks copying tasks to create new ones, you should avoid cutting and pasting tasks, particularly if you use Project Server, because cutting and pasting changes the unique ID's Project assigns to each task.
FIGURE 3.32
Project indicates the proposed position of the task with a horizontal gray line.

FIGURE 3.33
Both Book Meeting Space and Order Food tasks have detail tasks beneath them.
To copy tasks, you must first select them, using any of the techniques described in the previous section. To copy tasks, use the generic steps:

1. Select the tasks you want to copy.
2. Click the Task tab and, in the Clipboard group, click the Copy button to copy the selected tasks.
3. Click the task in the schedule that you want to appear below the tasks you’re copying.
4. Click the Task tab and, in the Clipboard group, click the top of the Paste button. Project pastes the tasks you selected in Step 1 above the selected task.

**Tip**

To copy a summary task and its detail tasks, you need only select the summary task and copy it. Project automatically copies the summary’s detail tasks for you.

If you have several repetitive phases of a project, such as the development and production of several models of a single product, you can use the fill handle to copy the tasks. Figure 3.34 shows three tasks: Design, Development, and Production. To copy a group of tasks such as Development and Production, follow these steps:

**FIGURE 3.34**

Take advantage of the fill handle for contiguous copy tasks.
1. Select their task names.

2. Place the mouse pointer over the fill handle in the lower-right corner of the selection. The mouse pointer changes to a plus sign (+).

3. Drag the fill handle down until you’ve selected the group of rows that you want to contain the repetitive tasks.

When you release the mouse pointer, Project copies the tasks into the selected range, as shown in Figure 3.35.

![Figure 3.35](image)

Project fills the range with the selected tasks.

**Caution**

The fill handle copies tasks into a contiguous range. However, if the range already contains information, using the fill handle to copy overwrites the existing information. To avoid this problem, insert blank rows in the project before using the fill handle. Select the task that you want to appear beneath the tasks you intend to copy. To insert more than one blank row, select the number of rows you want to insert. Then press the Insert key or click the Task tab and, in the Insert group, click the top of the Task button.
Displaying and hiding tasks

The outline structure enables you to view your project at different levels of detail by expanding or collapsing the summary tasks. You can use the Show Outline button on the View tab in the Data group to quickly hide or display detail tasks (also called subtasks) based on their level in the outline (see Figure 3.36). You also can quickly display all the detail tasks in your schedule.

**FIGURE 3.36**

Use the Show button on the View tab to easily determine the level of detail that you want to view in a project.

Figure 3.37 shows a minus sign (−) appearing to the left of each summary task. This symbol indicates that all subtasks are in view. If you click the minus sign, any subtasks disappear from view and a plus sign replaces the minus sign next to the summary task name. The plus sign indicates that the task is associated with some hidden detail tasks. Click the plus sign to reveal the “hidden” subtasks.

How many levels of detail can an outline have? Just about as many as you need. For example, the schedule that is shown in Figure 3.37 has several levels of detail regarding the annual meeting project. Any task that has subtasks also has the plus and minus sign mechanism for displaying or hiding the subtasks.
Caution

Using too many levels of outline indentation (usually more than three or four) makes it difficult to see your entire schedule on-screen. In fact, a very detailed project outline may indicate that you need to rethink the scope of the project and break it into smaller, more manageable projects.

You can use the hide and show features of the outline to focus on just the amount of detail you want. You can take the schedule shown in Figure 3.37, for example, and show just the highest level of detail for a report to management to summarize project activity (see Figure 3.38).

FIGURE 3.37
You can expand or collapse any task that has a subtask.
Getting Help

As you begin to build tasks in a schedule, you’re likely to have questions about using Project 2010 that the Help system can answer. Project’s Help is similar to the Help feature in Microsoft Office 2010 products.

Using the Help system

You click the Microsoft Project Help button located above the Ribbon at the right edge of the screen — beside the Minimize Ribbon button — to display the Help window (see Figure 3.39).

From the Help window, you can click a subject on which you want help, and Project displays a list of topics associated with the subject you selected (see Figure 3.40).

Tip

If you don’t see a topic that interests you, click the Home button (the one that looks like a house) to return to the Help window shown in Figure 3.39.
Chapter 3: Creating a New Project

FIGURE 3.39
You can use the Project Help window to search both online and offline sources for help.

When you click a topic, Project displays the Help text associated with that topic (see Figure 3.41). If you prefer, you can type a keyword in the Search box at the top of the Help window and click the Search button next to the box; Project searches for Help topics that include your keyword (see Figure 3.42).

The Table of Contents is a good way to view the structure of the Project Help file and see the topics under each subject. Click the Show Table of Contents button on the Help window toolbar to display the Help System’s Table of Contents. Click any book in the Table of Contents to see the topics associated with that subject. To hide the Table of Contents, click the Hide Table of Contents button on the Help window toolbar.

**Tip**
Use the buttons across the top of the Help window to move back and forward between Help topics — or click the Home icon to return to the opening Help window.
Part II: Getting Your Project Going

**FIGURE 3.40**
Project displays a list of topics after you select a subject.

**FIGURE 3.41**
A typical Help topic.
FIGURE 3.42
Use the Help system’s search engine to find Help topics on a subject.

Finding online help
On the Internet, you can find a world of support, information, and even freeware, shareware, or products for sale that work along with Project.

Using your browser, you can start your search at the Project Home Page:

http://Office.microsoft.com/en-us/project

At this site, you can find things such as update information, files to download, and software companies that provide add-on products or specialize in the use of Microsoft Project. You also can find links on this page to the Microsoft Project discussion groups, experts, and solution providers.
Summary

In this chapter, you started to build your first project by creating summary tasks and detail tasks, also called subtasks. You learned about the following aspects of Project:

- Gathering the data that you need to begin creating your schedule
- Entering Project information and setting up some calendar defaults
- Creating summary and detail tasks
- Using manual or automatic scheduling
- Saving files and closing Project
- Working with the outlining hierarchy to move, copy, and display detail tasks
- Using the Help system to search for information and obtain online help

In Chapter 4, you begin to add details about task types, add timing, and establish relationships among your tasks.
Building Tasks

Hesiod, that classic Greek project manager, once said, “Observe due measure, for right timing is in all things the most important factor.” You could do worse than to use this truism from around 700 B.C. as your personal project management mantra today. When it comes to projects, timing is, indeed, everything.

In Chapter 3 you created several tasks and used the outlining feature of Project to organize them. If you used automatic scheduling, every task in your schedule has the default length (one estimated day), and they all occur on the same day. If you used manual scheduling, no task has any length. In essence, you have listed the steps to get to your goal, but with no related timing information, and your schedule is more like a to-do list than a project schedule.

You have to add durations to your tasks. In other words, you must establish how long (or how many hours of effort) each task will take. However, timing consists of more than determining how many hours, days, or weeks it takes to complete each task. Timing for your project becomes clear only when you’ve set a duration for each task and when you’ve established the relationships, called dependencies, among the tasks. Only then can you accurately predict the amount of time that you will need to complete the project.

Note

Unless I state otherwise, I use automatic scheduling for the task mode throughout this chapter.

<table>
<thead>
<tr>
<th>IN THIS CHAPTER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establishing timing for tasks</td>
</tr>
<tr>
<td>Assigning task timing</td>
</tr>
<tr>
<td>Using recurring tasks</td>
</tr>
<tr>
<td>Establishing constraints and deadline dates</td>
</tr>
<tr>
<td>Manipulating the Gantt Chart to view timing</td>
</tr>
<tr>
<td>Entering task notes</td>
</tr>
<tr>
<td>Establishing dependencies among tasks</td>
</tr>
<tr>
<td>Viewing dependencies</td>
</tr>
<tr>
<td>Deleting dependencies</td>
</tr>
</tbody>
</table>
Establishing Timing for Tasks

In real life, you make estimates about task durations every day. Your boss asks how long it will take to write that report, and you tell her it will take about a week. Your coworker calls and asks when you will be finished repairing the computer network, and you tell him it will take another day. You know your own business, and you're probably pretty good at determining how long to allow for everyday tasks based on many factors.

Exactly how do you figure out the timing for a task in a project? The method is virtually identical to the seemingly automatic process you go through when someone asks you how long it will take to complete a task, such as placing an order for materials. Consider the following example:

1. You estimate that you'll spend about 40 minutes doing the research and performing the calculations to determine how many square feet of lumber you'll need for the job.

2. You consider how long the actual task (placing a phone order for materials) will take. This duration could be a matter of only minutes, but if you factor in playing a few rounds of phone tag, you may want to allow half a day.

3. You also think about what's involved in getting a purchase order. With your system, cutting a purchase order can take up to four days. Some of that time requires your presence, but most of it consists of waiting.

So how long is your task? You could say that you need exactly four days, four hours, and 40 minutes, but just to be safe, you should probably allow about five days. In addition, Project uses some specific methods that you need to understand to estimate task durations accurately.

In Project, you can create three different types of tasks: Fixed Unit, Fixed Work, and Fixed Duration. Project's behavior when you change the amount of resource effort you assign to the task varies, depending on the task's type.

Fixed Unit tasks

By default, using automatic scheduling, Project creates Fixed Unit tasks that are not affected by effort supplied by resources. That is, any changes you make do not affect the amount of any resource assigned to a task.

This task type ensures that resource allocations remain constant on the task. So, if you assign two resources — one at 100% and one at 50% — to a task and you remove the resource you assigned at only 50%, Project will not change the other resource's allocation to compensate.

Caution

This behavior is new in Project 2010; in prior versions, all new tasks were Fixed Unit, effort-driven tasks. You can change Project 2010’s behavior to emulate earlier versions if you prefer to work that way; see “Changing Task Type Default Behavior” later in this chapter.
To Pad or Not to Pad?

Although most people agree that delays are inevitable and that you should allow for them, people who schedule projects accommodate these delays in various ways.

Some schedulers build in extra time at the task level, adding a day or two to each task’s duration — just in case. Unfortunately, padding each task may leave you with an impossibly long schedule, and it may suggest to your boss that you’re not very efficient. Why should it take two days to run a three-hour test? It doesn’t — but because you know that setting up the test parameters properly the first time is an error-prone process, you allow a couple of work days to complete the testing. Just make sure that your boss understands that you’re building a worst-case scenario; when you bring the project in early, he or she will be glad to share the praise.

One school of thought on estimating task duration suggests that you take your estimate, double it, and then add 10%. If you are new to estimating, you might want to try this approach — as long as your project fits within the timeframe allotted for it — until you have an opportunity to track the progress of a few projects and learn just how accurately you estimate.

Some project managers add one long task, maybe two weeks or so in duration, at the end of the schedule, and they name it something like Critical Issues Resolution Period. This task acts as a placeholder that covers you if individual tasks run late. This approach can help you see how the overall time left for delays is being used up as the project proceeds. For example, if the final two-week task is running a week late because of earlier delays, you know that you’ve eaten up half of the slack that the task represents.

Or, you can build a schedule with best-case timing. Then you can document any problems and delays that occur, and request additional time as needed. In the case of a project that you must complete quickly, you may need to work this way. However, best-case timing sets you up for potential missed deadlines. Estimating a schedule with worst case timing sounds safe, because you’re unlikely to run out of time. But, if the estimate you provide is too long, the project might never happen because upper management will find better ways to spend the money.

Which approach should you use? Possibly a combination. For example, try building a best-case schedule. If the completion date is one week earlier than your deadline, by all means add a little time to the tasks that are most likely to encounter problems, such as those that are performed by outside vendors.

Fixed Work tasks

When you create a Fixed Work task, you set the duration of the task, and Project assigns a percentage of effort that is sufficient to complete the task in the time that is allotted for each resource that you assign to the task. For example, if you assigned three people to work on a one-day task, Project would say that each person should spend 33 percent of his or her time on the task to complete it in one day. Similarly, a task may take 48 hours to complete (its Fixed Work value). With one resource assigned working eight hours a day, the task will require six days to complete. With two resources assigned working eight hours a day, the task will require three days to complete. In either case, the amount of work that’s required remains constant. The task’s duration changes based on the number of resources that are assigned to the task. Fixed Work tasks are always effort driven; in just a moment, you read more about effort-driven tasks.
Fixed Duration tasks

You also can use the Fixed Duration task type in Project. The number of resources does not affect the timing of this type of task. To allow a week for a committee to review the company’s new ad campaign — no matter how many people are on the committee — give the task a fixed duration. You can’t shorten the task’s duration by adding resources to it. In fact, adding people to the review process may lengthen the task, because their effort has no impact on getting the work done more quickly, and coordinating their efforts can add time.

Effort-driven tasks

Almost every task is affected by the effort supplied by resources. Here’s a simple example: Suppose you have to plant a tree. One person needs two hours to plant a tree. If you add another person (another resource), then it’s reasonable to assume that together they need only one hour to complete the task. That is, two resources, each putting in an hour of effort, complete the two hours of work in only one hour. With resource-driven scheduling, when you add resources, the task duration becomes shorter; if you take away resources, the task takes longer to complete. And, on the flip side, the resource assignments to a task don’t change when the work increases or decreases.

Caution

The reduction of time required on a resource-driven task is strictly a mathematical calculation in Project. for example, ten people get work done in one-tenth the time of one person. However, whenever two or more people work on a task, the time savings are seldom so straightforward. You must also factor in the time for those people to communicate, miscommunicate, hold meetings, and so on. ■

Every Fixed Work task you create in Project is effort-driven by default, and you cannot change that task type to not be effort-driven. For Fixed Duration and Fixed Unit tasks, you can tell Project to modify the percentage of total work that is allocated to each resource, based on the number of assigned resources, if the number of resources changes. In effect, you create an effort-driven task. The work that’s required to complete the task remains the same, but Project redistributes the work equally among all assigned resources. Table 4.1 summarizes Project’s behavior for each task type in relation to effort-driven scheduling.

<table>
<thead>
<tr>
<th>Task Type</th>
<th>When Effort-Driven</th>
<th>When Not Effort-Driven</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Work</td>
<td>If you add resources, Project shortens the task’s duration.</td>
<td>Not applicable, because all Fixed Work tasks are effort-driven.</td>
</tr>
<tr>
<td>Fixed Unit</td>
<td>If you add resources, Project shortens the task’s duration.</td>
<td>Adding resources doesn’t affect the task’s units or duration, but Project increases the task’s total work.</td>
</tr>
<tr>
<td>Fixed Duration</td>
<td>Because the task’s duration is fixed, adding resources doesn’t affect the task’s duration, but Project reduces the allocation of each resource.</td>
<td>The task’s duration and all resource allocations remain the same when you add resources, but Project increases total work.</td>
</tr>
</tbody>
</table>
Note
In this book, I change Project’s default settings so that the durations that you assign to tasks are resource-driven and a five-day task requires five days of resource effort to complete. See the next section to find out how to change Project’s default settings. In Chapter 5, you find out more about how resource assignments modify task timing.

Changing Task Type Default Behavior
In earlier editions of Project, the default task type was Fixed Unit, effort-driven. In Project 2010, the default task type is not effort-driven. If you prefer the behavior of earlier versions of Project, you can change the default settings. Here’s how:

1. Click the File button.
2. From the Back Stage view, click Options.
3. In the Project Options dialog box (see Figure 4.1), click Schedule on the left.
4. In the Scheduling Options For This Project list box, select All New Projects.

FIGURE 4.1
Changing Project options to make all new tasks effort-driven.
Part II: Getting Your Project Going

**Tip**
If you enter predominantly Fixed Work tasks or Fixed Duration tasks, click the Default Task Type list-box arrow and select the appropriate task type.

5. Click New Tasks Are Effort-Driven.
6. Click OK.

Repeat these steps for the current project; that is, in Step 4, select the current project instead of All New Projects.

For the remainder of this book, I set up Project to insert new tasks that are, by default, Fixed Unit, effort-driven tasks.

**Assigning Task Timing**

You now understand the basics of estimating task timing, and you understand how task timing relates to effort that is expended on the task by resources. The actual process of assigning durations is simple. To assign a duration to a task, you can use one of the following three methods:

- Enter a duration in the Duration column of the Gantt table.
- Use the Task Information dialog box to enter and view information about all aspects of a task, including its timing, constraints, dependencies, resources, and priority in the overall project.
- Use your mouse to drag a task bar to the required length.

**Note**
You also can enter the work value after assigning the resources to the task. Project then calculates the duration and provides smart tag help, giving you the option to change the method of calculation.

**Using the Gantt table**

To enter a task's duration in the Entry table portion of the Gantt Chart view, simply click the Duration column and enter the duration. Using automatic scheduling, you might have noticed that Project uses estimated durations — a question mark (?) — by default when you type a task name but no duration. Even though Project initially assigns estimated durations to tasks, when you type a duration, Project assumes that you want a planned rather than an estimated duration — unless you enter a question mark (?).

**Tip**
You can change Project’s default behavior (and use planned rather than estimated durations) on the Schedule tab of the Options dialog box. See the next section for more information.
You can enter a duration in a few different ways. For example, Project recognizes all the following entries as three weeks: 3 w, 3 wks, 3 weeks.

**Tip**

To assign the same duration to several contiguous tasks, enter the duration once and then use the fill handle in the Duration column to copy the duration to the other tasks.

When you type a duration, Project uses the Change Highlighting feature to show you the other tasks in your project that are affected by the scheduling change you made (see Figure 4.2). In this example, the task I changed — Acquire Materials — and the summary task, Phase One Testing, were both affected by the duration I entered. In particular, the finish dates of both tasks were changed by the duration I provided.

**FIGURE 4.2**

When you change a task’s duration, Project highlights other tasks affected by the change.
Tip
If the information you enter has results you weren’t expecting, you can click the Undo button on the QAT to reverse the effects. In Project 2010, each time you click the Undo button, Project reverses the effects of each change you made, in the order you made them. If you click Undo enough times, Project can return your file to the state in which it appeared when you last saved the file.

Using the Task Information dialog box
Follow these steps to assign durations from the Task Information dialog box:

1. Display the Gantt Chart view by clicking the Gantt Chart view shortcut at the right edge of the Status Bar.
2. Double-click a task name to open the Task Information dialog box (see Figure 4.3).

FIGURE 4.3
If you double-click a task name you already entered, it appears in the Name field in this dialog box. If you double-click a blank task-name cell, you can fill in the name here.

Tip
You can also display this dialog box if you click the Task Information button in the Properties group of the Task tab or right-click either the task name or the task’s Gantt bar and select Task Information.

3. Click the arrows in the Duration field to increase or decrease the duration from the default setting of one day. Each click changes the duration by one day.

Note
If you change the duration in the Task Information dialog box, Project assumes you want a planned duration and also removes the check from the Estimated box.
To enter a duration in increments other than a day, you can click the Duration field, highlight the current entry, and type a new duration using any of the following abbreviations: \(m\) for minutes, \(h\) for hours, \(w\) for weeks, and \(mo\) for months.

**Note**

Project uses the Schedule tab of the Project Options dialog box to determine the number of days in a month.

4. Click OK to establish the task duration. The task’s Gantt Chart bar reflects the new task length (see Figure 4.4).

---

**FIGURE 4.4**

Task bars become more meaningful after you assign durations.
Part II: Getting Your Project Going

Start and finish versus duration

You can use the Start and Finish fields in the Task Information dialog box to set a start date and finish date for the task rather than enter a duration. However, if you use the Start and Finish dates, Project uses only working days in that date range. If you enter a duration, Project calculates the beginning and end of the task, taking into consideration weekends and holidays. These two methods can have different results and most often, you’ll find that using durations produces better results than using Start and Finish dates.

For example, suppose you have a five-day task that starts on December 22, 2009 and you’ve set up the project’s calendar to make December 25 a nonworking day. The following table shows how that week and the following week look on a calendar: December 25, 2009, falls on a Friday.

<table>
<thead>
<tr>
<th>Sun</th>
<th>Mon</th>
<th>Tues</th>
<th>Wed</th>
<th>Thurs</th>
<th>Fri</th>
<th>Sat</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you entered 12/22/09 as the start date and 12/28/09 as the finish date, Project would calculate that as an estimated four-day task, with work on December 22, 23, 24 and 28. However, if you enter four days in the Duration field, the calculated start and finish dates would be 12/22/09 and 12/29/09, respectively — taking into account both the Christmas holiday and a weekend. In this example, the work days are December 22, 23, 24, 28, and 29.

If a task has immutable timing, such as a Christmas celebration on Christmas day, use the Start and Finish fields. Except for days you establish as non-working days, Project will force the task to start on the Start Date you establish and expect it to finish on the Finish Date you set, which could upset the timing of both earlier and later tasks. If you know how many work days a task will require, but not the days on which the work will occur, use the Duration field to set timing, and let Project calculate the actual work dates based on the calendar.

Using your mouse and the task bar

Finally, follow these steps to adjust a task’s duration using your mouse and the task bar:

1. Place your mouse pointer on the right edge of a task bar until the pointer becomes a vertical line with an arrow extending to the right of it.
2. Click and drag the bar to the right. As you do, Project displays the proposed new task duration and finish date, as shown in Figure 4.5.
3. Release the mouse button when the duration you want appears in the information box.

Note

When you use the mouse to set a task duration, Project does not make the duration a planned duration; instead, the duration remains an estimated one. To change the duration from estimated to planned, you must make the change using one of the two preceding methods described — the Gantt table or the Task Information dialog box.
FIGURE 4.5
If you’re a visually oriented person, dragging task bars to change durations might be the best method for you.

Setting scheduling options
You aren’t limited to entering resource-driven tasks or estimated durations on the Gantt table. You can change the default task type and other default scheduling settings for your project. Click the File tab and, in the Back Stage view that appears, click Options. On the left side of the Project Options dialog box, click Schedule to change the default settings for entering tasks (see Figure 4.6).

In the section Scheduling Options in This Project section of the Project Options dialog box, you determine default information such as the default unit of time for new task durations (the default is days), the work time (hours), and whether Project schedules new tasks to start on the project start date or on the current date. If, for example, you don’t want to use estimated durations for new tasks, remove the check mark from the New Scheduled Tasks have Estimated Durations check box. Or, if you’re working on a five-year project in which most tasks take months — not days — change the default setting for the Duration Is Entered In field. If you prefer that new tasks begin no earlier than the current date, you can open the New Tasks Created list box and select Scheduled On Current Date.
Part II: Getting Your Project Going

FIGURE 4.6
Use the Scheduling Options section in the Project Options dialog box to change Project’s default behavior when scheduling tasks.

As you gain experience in entering information, you’ll find ways to customize Project to match your work style. When you are satisfied with the settings in the Schedule tab, click OK to close the Project Options dialog box.

Assigning a calendar to a task
You can assign a calendar to a task by using the same steps that you used to create the Press calendar, described in detail in Chapter 3. Click the Project tab and, in the Properties group, click Change Working Time to display the Change Working Time dialog box. Click the Create New Calendar button to create the calendar, and then provide a name for the new calendar. Then create the calendar exceptions that apply to the task and click OK to save the calendar.

Cross-Reference
For more detailed steps on creating a new calendar and calendar exceptions, see Chapter 3.

To assign a calendar to a task, double-click the task name to open the Task Information dialog box for that task. Click the Advanced tab and open the Calendar list box to assign a special calendar for the task (see Figure 4.7).
Assign a calendar to a task from the Advanced tab of the Task Information dialog box.

Creating milestones

Managers often use milestones to mark key moments in a project, such as the completion of a phase or the approval of a product or activity. In Project, milestones are tasks that usually have zero duration. The symbol for a milestone on the Gantt Chart is a diamond shape. For example, the diamond in the Gantt Chart shown in Figure 4.8 indicates that the End of Testing task is a milestone.

A milestone typically marks a noteworthy point in your project; a milestone is usually a task of no duration.
A task doesn’t have to have a zero duration to be a milestone; you can mark any task as a milestone. On the Advanced tab of the Task Information dialog box, place a check mark in the Mark Task As Milestone check box. In this case, the task duration doesn’t change to zero. However, the element that represents the task in the Gantt Chart changes from a bar, reflecting the task’s duration, to a milestone diamond symbol, representing the task as a moment in time.

**Note**

For milestones with durations longer than zero, the diamond appears at the beginning of the duration.

**Timing for summary tasks**

How do you assign durations for summary tasks? You don’t have to assign a duration to a summary task and, if you want your summary task to represent the total timing of its subtasks, then don’t enter a duration for a summary task. For example, if three subtasks occur one right after the other and each is three days long, the summary task above them takes nine working days from beginning to end if you don’t assign a duration to it (see Figure 4.9). If you do change the duration of any of those tasks, Project will update the summary task accordingly.

**FIGURE 4.9**

Using a summary task to represent the total timing of its subtasks.
Note, however, that you can assign a duration to a summary task — and you might want to make such an assignment in certain cases. Suppose, for example, that you’re starting a project and you can easily identify that it has five phases. You also know that Phase 1 can last six weeks, and you know some of the tasks in that phase, but they only account for three weeks of the phase. In this case, enter your phases and, under each phase, enter the tasks you know.

**Tip**
You can use manually scheduled or automatically scheduled tasks and you don’t need to enter durations for the tasks.

Indent the known tasks under each phase, establishing the phase task as a summary task (see Figure 4.10). In the duration column for the summary task, enter the phase’s duration; Project automatically makes the summary task a manually scheduled task, as you can see in the Task Mode column, and Project accounts for the duration of the phase by the length of the summary task bar in the chart portion of the Gantt Chart view.

Because the summary task is a manually scheduled task, Project respects any dates or durations you assign and won’t change them, even if you make changes to a detail task under the summary task. But Project tracks your manually entered information along with information it calculates; if you hover your mouse on the summary task bar, Project displays the planned dates for the summary task as well as the calculated dates for the detail tasks (see Figure 4.11). And whether you use manually scheduled tasks, automatically scheduled tasks, or a mix of both, Project still displays both sets of dates.

**FIGURE 4.10**
You can assign a duration to a summary task.
Part II: Getting Your Project Going

**FIGURE 4.11**
Project tracks the information you assign to a summary task along with its calculations for the associated detail tasks.

**Note**
If you edit the duration of an automatically scheduled summary task, Project converts it to a manually scheduled task.

Using this approach, you can create a schedule that you plan from the top down and, if you use manually scheduled tasks, you can control all the dates in the schedule. You can create tasks that begin before the start of a phase and tasks that end after the end of the phase. But remember: You don’t need to use a manually scheduled task to assign a duration to a summary task. If you assign a duration to an automatically scheduled task, Project converts the task to a manually scheduled task.

**Note**
You can have Project display a summary task for your entire project. The project summary task displays the total time for a project, and, using a project summary task and a Cost Resource, you can establish a budget for your entire project. To learn more about Cost Resources, see Chapter 5. To learn more about project budgets, see Chapter 12.
Using Recurring Tasks

Projects often have tasks that occur on a regular basis. Weekly staff meetings, quarterly reports, or monthly budget reviews are examples of these recurring tasks. Rather than create, for example, 20 or so weekly staff-meeting tasks over the life of a five-month project, you can use Project’s Recurring Task feature. This feature enables you to create the meeting task once and assign a frequency and timing to it. Follow these steps to create a recurring task:

1. Because Project inserts tasks above the selected task, select the task that you want to appear below the recurring task.
2. Click the Task tab and, in the Insert group, click the bottom of the Task button; from the menu that appears, choose Recurring Task button to open the Recurring Task Information dialog box, as shown in Figure 4.12.
3. Type a name for the recurring task.
4. Set the task duration in the Duration field. For example, does the meeting run for two hours, or does a report take a day to write?
5. Set the occurrence of the task by selecting one of the Recurrence Pattern option buttons: Daily, Weekly, Monthly, or Yearly. Depending on the recurrence you select, the timing settings to the right of the control buttons change. Figure 4.12 shows the Weekly settings.
6. Select the appropriate settings for the recurrence frequency. For a Weekly setting, place a check mark next to the day(s) of the week on which you want the task to occur. For example, the task shown in Figure 4.12 occurs every Tuesday. For the Monthly or Yearly setting, select the day of the month on which you want the task to occur.

Note

For a daily task, you have only one choice: whether you want it to occur every day or only on scheduled workdays. For example, to schedule a computer backup for every day of the week — regardless of whether anyone is at work — you can have the task occur every day. (Ask your IT department how to automate the process so it occurs even when nobody is at work.)

7. Set the Range of recurrence — the period during which the task should recur — by entering Start and End After or End By dates. If you need to repeat a test weekly for only one month of your ten-month project, you can set Start and End After or End By dates that designate a month of time.

Tip

If you set the End After number of occurrences, Project calculates the date range required to complete that many occurrences of the recurring task and automatically displays the ending date in the End By box. This method can be useful if one of these events falls on a holiday; if that happens, Project displays a box that allows you to skip the occurrence or to schedule it on the next working day. For a weekly staff meeting, you can skip that meeting or schedule it on a different day. On the other hand, if you must repeat a test 16 times during the project cycle, you can schedule the test to occur on the next working day to compensate for the holiday. Therefore be sure you set the number of occurrences rather than the time range.
8. Click OK to create the task. Project creates the appropriate number of tasks and displays them as subtasks under a summary task with the name that you supplied in Step 2. In Figure 4.13, I expanded the view of the summary task so you can see each recurring task; note the recurring task symbol in the Indicators column of Row 6.

**FIGURE 4.12**

If a task occurs at regular intervals during the life of a project, you can save time by creating it as a recurring task.

**FIGURE 4.13**

Task bars appear for each occurrence of the recurring task in the Gantt Chart.
Mysterious Icons in the Indicator Column

The symbol next to each Weekly Test Report task in the schedule shown in Figure 4.13 represents a task with a timing constraint applied. Project applies this constraint automatically as you enter settings for the recurring task.

If you move your mouse pointer over one of these symbols, as I did in the following figure, you can see an explanation of that constraint. For example, each Weekly Test Report task has a Start No Earlier Than constraint, based on the timing you set in the Recurring Task Information dialog box. The first recurring task can start no earlier than the From date entered there, and each task occurs weekly thereafter. You find out more about setting timing constraints in the next section.

Constraints affect the timing of a task relative to the start or end of your project, or relative to some other specified date. Setting a deadline date in Project provides you with a visual reminder if you don’t complete a task by the deadline date that you establish.
Establishing Constraints and Deadline Dates

Constraints affect the timing of a task relative to the start or end of your project or to a specific date. Setting a deadline date in Project provides you with a visual reminder if you don’t complete a task by the deadline date that you establish.

Understanding constraints

By default, Project sets all automatically scheduled tasks to start with an As Soon As Possible constraint. Barring any dependency relationships with other tasks (see the “Establishing Dependencies Among Tasks” section later in this chapter), the task would start on the first day of the project. You can set other constraints as follows:

- **As Late As Possible**: This constraint forces a task to start on a date such that its end occurs no later than the end of the project.
- **Finish No Earlier Than/Finish No Later Than**: This constraint sets the completion of a task to fall no sooner than or later than a specific date.
- **Must Finish On/Must Start On**: This constraint forces a task to finish or start on a specific date.
- **Start No Earlier Than/Start No Later Than**: This constraint sets the start of a task to fall no sooner or later than a specific date.

Only the Must Finish On/Must Start On settings constrain a task to start or end on a particular date. All the other settings constrain the task to occur within a specified time frame.

Using deadline dates

You also can establish a deadline date for a task. The deadline date differs from a constraint in that Project doesn’t use the deadline date when calculating a project’s schedule. Instead, the deadline date behaves as a visual cue to notify you that a deadline date exists (the down-arrow symbol that you see next to the Acquire materials 2 task bar in Figure 4.14). If you place your mouse over the deadline indicator, Project displays the deadline information. If the task finishes after the deadline date, you also see a symbol in the Indicators column. Keep in mind that you won’t see an indicator if you complete the task prior to the deadline date.

Although deadline dates don’t affect the calculation of a project schedule, they do affect a Late Finish date and the calculation of total slack for the project. Also, be aware that you can assign both a deadline date and a constraint to a task. In a project that you schedule from a beginning date, a deadline date has the same effect as a Finish No Later Than constraint in the calculation of slack. If you assign deadline dates to tasks in projects that you schedule from an ending date, those tasks will finish on their deadline dates unless a constraint or a dependency pushes them to an earlier date.
Setting constraints and deadline dates

You set constraints on tasks in your project by using the Advanced tab of the Task Information dialog box (see Figure 4.15). Select a constraint type from the Constraint type drop-down list. For all settings in the type list other than As Late As Possible and As Soon As Possible, designate a date by clicking the arrow next to the Constraint Date field and choosing a date from the drop-down calendar that appears. Set a deadline date by clicking the arrow next to the Deadline field and choosing a date from the drop-down calendar that appears.

Under what circumstances would constraints be useful? Consider the following situations:

- A project involves preparing a new facility for occupancy, and you want the final inspection of that facility to happen as late as possible.
- The approval of a yearly budget must finish no later than the last day of the fiscal year, ready to begin the new year with the budget in place.
- Billing of a major account must start no sooner than the first day of the next quarter so the income doesn’t accrue on your books this quarter.
- Presentation of all severance packages for laid-off employees must finish on the day that a major takeover of the company is announced.
Deadline dates would be useful in the following situations:

- You need to prepare the annual budget by a deadline date to ensure approval in time to begin the new year with the budget in place.
- You need to prepare severance packages for laid-off employees so you can present the packages on the day that a major takeover of the company is announced.

You see how constraints and dependencies interact in establishing the timing of tasks in the section “Establishing Dependencies Among Tasks,” later in this chapter.

**Entering Task Notes**

You can attach notes to individual tasks to remind you of certain parameters or details for the task. For example, if a task involves several subcontractors, you may want to list their contact information here so it’s close at hand when you’re working on the project schedule. Or you can use the Notes field to document company regulations that are relevant to that type of procedure. When you add a note to a task, you can display the note on-screen and include the note in a printed report.

**Cross-Reference**

You can also attach notes to individual resources and to their assignments, as you find out in Chapter 5.

To enter a note for a task while viewing the Gantt Chart, follow these steps:

1. Double-click a task to open the Task Information dialog box.
2. Click the Notes tab, as shown in Figure 4.16.
3. Type your note in the area provided. You can use the tools provided just above the description box to format your note text.
The Notes tab provides simple word processing, such as tools for formatting your notes.

4. Click OK to attach the note to your task.
   A Note icon now appears in the Indicators column of the Gantt table (see Figure 4.17).
   Move the mouse pointer over this icon to display the note.

Project automatically adds an icon for the note to the Indicators column.
You can print notes along with your schedule. To print the Gantt Chart view and task notes, follow these steps:

1. Click the File tab and, in the Back Stage view, click Print.
2. Click the Settings button.
   Project displays settings you can select when printing a project (see Figure 4.18).

3. Click Notes to have Project print notes for tasks.
4. Select any other settings you want.
5. Click the Print button.
   Project prints notes on a separate page after printing the Gantt Chart view.
Establishing Dependencies Among Tasks

Whereas constraints tie tasks to the project start or end or to particular dates, dependencies tie tasks to the timing of other tasks in the project. Dependencies are central to visualizing the true length of a project.

Dependencies exist because all tasks in a project rarely can happen simultaneously; usually some tasks must start or finish before others can begin. Tasks happen at different times for many reasons; resources might be unable to work on more than one task at a time, a piece of necessary equipment might be unavailable, or the nature of the tasks themselves might drive the timing of the tasks — for example, you can’t start construction until you receive a construction permit.

You can’t know the total time needed to complete a project until you establish durations and dependencies. For example, a project that comprises five 10-day-long tasks — with no dependencies among the tasks — takes 10 days to complete. If the tasks must happen one after the other, the project requires 50 days. And if some tasks can happen simultaneously while others must happen one after the other, you won’t know the total time needed to complete the project until you establish the durations and dependencies for all tasks in the project.

Understanding dependencies

A task that must occur before another task is a predecessor task. The task that occurs later in the relationship is a successor task. Each task can have multiple predecessors and successors. Tasks with dependency relationships are linked. Gantt Charts show these links as lines running between task bars; an arrow at one end points to the successor task. Some dependency relationships are as simple as one task ending before another can begin — but some relationships are much more complex. For example, if you’re moving into a new office and the first task is assembling cubicles, you don’t have to wait until all the cubicles are assembled before you begin moving in furniture. You might work in tandem, using the first morning to set up cubicles on the first floor. Then you can begin to move chairs and bookcases into the first-floor cubicles while the setup task continues on the second floor.

Understanding the interactions between constraints and dependencies

Both constraints and dependencies drive the timing of a task. Consider for a moment how constraints and dependencies might interact when you apply one of each to a task. Suppose you have a task — the opening of a new facility — that has a constraint set so it must start on November 6. You then set up a dependency that indicates that the task should begin after another specified task — fire inspection — that is scheduled for completion on November 10. When you try to set up such a dependency, Project displays a Planning Wizard dialog box that indicates a scheduling conflict (see Figure 4.19). Project displays this dialog box when a conflict exists among dependencies or between constraints and dependencies.
Multiple dependencies or a combination of dependencies and constraints can cause conflicts in timing.

If a conflict exists between a constraint and a dependency, the constraint drives the timing of the task; the task does not move from the constraint-imposed date. You can modify this functionality in the Project Options dialog box. Click the File tab and, from the Back Stage view, click Options. Then, click Schedule and, in the Scheduling Options In This Project section, remove the check mark from the Tasks Will Always Honor Their Constraint Dates check box. When you change this option, dependencies — rather than constraints — will determine timing.

**Cross-Reference**

See Chapter 10 for more information about resolving timing conflicts.

You can create dependencies in one of the following three ways:

- You can select two tasks and click the Link Tasks button in the Schedule group of the Task tab on the Ribbon. The first task you select becomes the predecessor in the relationship.
- You can open the successor task's Task Information dialog box and enter predecessor-task information on the Predecessors tab.
- You can click the Gantt bar of a predecessor and drag it to the Gantt bar of a successor task.

**Tip**

To link a whole range of tasks so they're consecutive (one finishes, the next begins, and so on down through the list of tasks), select the range of tasks (drag from the ID number of the first task to the ID of the last task). Then use the Link Tasks button to create a string of such relationships.

**Allowing for delays and overlap**

Although many dependency relationships are relatively clear-cut — Task A can begin only when Task B is complete, or Task C can start only after Task B has started — some are more finely delineated. These relationships involve delay and overlap, and these relationships are supported in Project by adding lag time or lead time to the dependency relationship.

To understand these two concepts, consider the following examples. Suppose your project tests a series of metals. In the first task, you apply a chemical solution to the metal, and in the second task, you analyze the results. But time can be a factor here, so you want the analysis to begin only...
when several days have passed after the application of the chemical solution. You build in a delay between the finish of the first task (the predecessor) and the start of the second (the successor). Figure 4.20 shows a relationship with some lag — delay — between the two tasks. The line between the two tasks indicates the dependency, and the space between the bars indicates the delay in time between the finish of one task and the start of the next.

You create lag or lead time using the Predecessors tab of the Task Information dialog box. You create lag time by entering a positive duration in the Lag field, and you create lead time by entering a negative duration in the Lag field.

**Note**
Some people prefer to build a task to represent lag rather than to modify a dependency relationship. For example, instead of placing a dependency between application of the solution and analysis, you can create a three-day-long task called Solution Reaction Period. Then create a simple dependency relationship between Solution Reaction Period and the analysis so that the analysis task won’t begin until Solution Reaction Period is complete. Adding the lag tasks can generate a very long schedule with multiple tasks and relationships to track. But in a simpler schedule, this approach enables you to see relationships as bars on the Gantt Chart. You can try both methods and see which works best for you.

**FIGURE 4.20**
Here, after you apply the chemical solution, you must wait four days before analyzing the results.
Another test in your project involves applying both a solution and heat. You first want to apply the solution for three days, but one day before you finish applying solution, you want to begin to apply heat as well. Notice the overlap between the tasks: the predecessor task — applying the solution — begins on November 12 and runs through November 14. The successor task — Applying Heat — begins one day before the end of the predecessor task, on November 14. The project shown in Figure 4.21 has some overlap between tasks, created by adding one day of lead time to the successor task.

**Dependency types**

Four basic dependency relationships define the relationship between the start and finish of tasks: start-to-finish, finish-to-start, start-to-start, and finish-to-finish. You can set these dependency relationships on the Predecessors tab of the Task Information dialog box, as shown in Figure 4.22.
Four types of dependencies enable you to deal with every variable of how tasks can relate to each other’s timing.

**Tip**

Use the Lag column on the Predecessors tab of the Task Information dialog box to create lag or lead time between tasks, entering a positive number for lag time or a negative number for lead time.

The first timing mentioned in each relationship name relates to the predecessor task and the second to the successor. Therefore, a start-to-finish dependency relates the start of the predecessor to the finish of the successor, and a finish-to-start relationship relates the finish of the predecessor to the start of the successor. Project refers to these relationships by their initials, such as SS for a start-to-start relationship.

**Tip**

As you view the figures in the following sections, take note of the direction that the arrow points between tasks. The direction of the arrow provides important visual clues about the type of dependency.

**Finish-to-Start (FS)**

A finish-to-start relationship is the most common type of dependency and is, in fact, the only relationship that you can create by using your mouse or the Link Tasks tool or command. In the finish-to-start relationship, the successor task can’t start until the predecessor task finishes. Examples of this relationship are as follows:

- You must write a report before you can edit it.
- You must have a computer before you can install your software.

In Figure 4.23, you see examples of the FS relationship in which the successor task can start as soon as its predecessor is finished. The following tasks have a finish-to-start relationship:
Part II: Getting Your Project Going

- Task 2 and Task 3
- Task 3 and Task 4
- Task 4 and Task 5

Note
The relationship between Tasks 4 and 5 also contains some lag time, as discussed the section “Allowing for delays and overlap,” earlier in this chapter.

Start-to-Finish (SF)
With the start-to-finish relationship, the successor task cannot finish until the predecessor task starts. The following are some examples:

- You can finish scheduling production crews only when you start receiving materials.
- Employees can start using a new procedure only when they have finished training for it. If the use of the new procedure is delayed, you also want to delay the training so that it occurs as late as possible before the implementation.
Note
Can you set up this start-to-finish example as a finish-to-start relationship? Not really. The idea is to allow no delay between training and implementation. If you set the new procedure to start only when the training finishes, the new procedure can start any time after the training ends, depending on how other relationships may delay it. If the training task has to finish just before the other task starts, delays of the later task (implementation) also delay the earlier task. This fine distinction will become clearer as you see more real-world projects in action.

Figure 4.24 shows a start-to-finish relationship between acquiring materials for Phase Two Testing and completing the analysis of Phase One Testing. Assuming that the test results of Phase One determine the materials that you’ll need for Phase Two, you can’t begin acquiring materials for Phase Two Testing until you have completed the analysis of Phase One Testing. Notice the direction of the arrow that connects the two tasks; it provides a visual clue of the type of dependency that exists between the tasks. In fact, the direction of the arrow in all dependencies provides you with valuable information.

**FIGURE 4.24**
The successor task can’t finish until the predecessor task starts.
Start-to-Start (SS)
In a start-to-start relationship, the successor can't start until the predecessor starts. Consider the following examples:

- When you start getting results in an election, you can begin to compile them.
- When the drivers start their engines, the flagger can start the race.

In Figure 4.25, Tasks 10 and 11 have a start-to-start relationship. Although you'll need three days to complete the analysis, you can start the analysis as soon as you begin applying heat.

Finish-to-Finish (FF)
In the finish-to-finish dependency, the successor task can't finish until the predecessor task finishes. Consider the following examples:

- You finish installing computers at the same time that you finish moving employees into the building so that the employees can begin using the computers right away.
- Two divisions must finish retooling their production lines on the same day so that the CEO can inspect the lines at the same time.

FIGURE 4.25
The successor task can’t finish until the predecessor task starts.
Suppose that, in Phase Two of the testing shown in Figure 4.26, you can begin preparing the chemical solution (Prepare solution 2) while you’re still acquiring materials (Acquire materials 2). Note, however, that you can’t finish preparing the chemical solution until you finish acquiring the materials. Therefore, set up a finish-to-finish dependency between these two tasks to make sure that you don’t finish preparing the solution if you experience a delay in acquiring materials.

**Establishing dependencies**

As previously mentioned, you can set dependencies in several different ways. If you use the tasks in the Gantt table or the bars on the Gantt Chart to set dependencies, you must establish finish-to-start relationships. To establish more complex relationships, including lag and lead, use the Task Information dialog box.

**Figure 4.26**

The successor task can’t finish before the predecessor task finishes.

Project enables you to use summary tasks when setting dependencies with some limitations. You can set dependencies between two summary tasks or between a summary task and a detail task in another task group, regardless of the task mode (automatic or manual scheduling) of the tasks involved in the relationship. When you’re setting dependencies between summary tasks, you can
Part II: Getting Your Project Going

use either a finish-to-start or a start-to-start dependency; you cannot use any other type of dependency. You also cannot set dependencies between a summary task and any of its own subtasks. When you set a dependency between a summary task and a detail task in another task group, however, you can set any type of dependency you choose.

**Setting finish-to-start dependencies**

With the Gantt Chart displayed, you can use your mouse to drag between Gantt bars or click the Link Tasks button to set finish-to-start dependencies. Use the following steps to set a simple finish-to-start relationship by dragging between Gantt bars:

1. Place your mouse pointer over the predecessor task until the pointer turns into four arrows pointing outward.
2. Drag the mouse pointer to the second task. An information box describes the finish-to-start link that you are about to create, and the mouse pointer changes to a chain link (see Figure 4.27).
3. Release your mouse button when you’re satisfied with the relationship, and Project establishes the link.

**FIGURE 4.27**

The relationship isn’t established until you release the mouse button. If you have second thoughts, just drag the pointer back to the predecessor task before releasing your mouse button.
To use the Link Tasks button, simply follow these steps:

1. Select the tasks you want to link.
   - To select adjacent tasks, drag through their ID numbers in the Gantt Chart table.
   - To select nonadjacent tasks, hold down Ctrl as you click the ID numbers of the tasks that you want to link.

2. Click the Task tab and, in the Schedule group, click the Link Tasks button.
   Project establishes the link.

Setting other types of dependencies
You can use either the Task Information dialog box or the Task Dependency dialog box to set any type of dependency. Use the Task Dependency dialog box shown in Figure 4.28 to establish dependency types or lag or lead times between tasks. To open the Task Dependency dialog box, double-click the line that connects the tasks you want to change. Remember, you set lag time using a positive number in the Lag box, and set Lead time by supplying a negative number in the Lag box.

![Figure 4.28](image.png)

You also can use the Task Information dialog box to establish dependencies and lag or lead times. If you choose to use the Task Information dialog box, open the dialog box for the successor task and build the relationship on the Predecessors tab.

Follow these steps to create a task dependency:

1. Double-click the task that you want to make a successor. When the Task Information dialog box appears, select the Predecessors tab.
2. Click the Task Name column; an arrow appears at its far end.
3. Click the arrow to the right of the column to display the drop-down list of task names, as shown in Figure 4.29.
4. Click the task that you want to identify as the predecessor to this task.
5. Click the Type field; a list box arrow appears.
6. Click the arrow to display a list of dependency types and select the type of dependency that you want to establish, such as start-to-start or start-to-finish.
Part II: Getting Your Project Going

FIGURE 4.29
Every task you create for your project appears on this list.

To establish a dependency with no lag or lead, click OK at this point to create the relationship. To establish a delay, click the Lag column and supply an amount of time for the delay. To establish an overlap, simply enter a negative number in the Lag column. For example, if you want the successor to finish one week before the predecessor finishes, use a finish-to-finish relationship and enter 1 week in the Lag column. To establish lead time, supply a positive number in the Lag column.

Tip
Here’s a quick way to create Finish to Finish, Start to Finish, or Start to Start relationships. Create the default Finish to Start relationship for the tasks. Then double-click the link line to open the Task Dependency dialog box and change the relationship.

Viewing Dependencies

After you’ve established several dependencies in a project, you can study them in several ways. You can, of course, open each task’s Task Information dialog box and look at the relationships listed on the Predecessor tab. You can also view the lines drawn between tasks to see dependencies. You can scroll to the right in the Gantt table, or you can reduce the size of the Gantt Chart to see more of the Gantt table and display the Predecessors column, as shown in Figure 4.30. This column lists any relationships, using the two-letter abbreviations for the dependency type and positive and negative numbers to show lag and overlap.

Or, you can use the Task Inspector pane, shown in Figure 4.31, to explore the relationships among your tasks. To display the Task Inspector pane, click the Task tab and, in the Tasks group, click the Inspect button. Project displays information for the currently selected task, and you can click any task in the project schedule to see its information.
FIGURE 4.30
Display the Predecessors column to show all the relationships for a task.

FIGURE 4.31
You can use the Task Inspector pane to explore task relationships.
Cross-Reference
You can read more about the Task Inspector in Chapter 10.

The information that appears in the Task Inspector pane changes, depending on whether the task is scheduled manually or automatically and depending on whether you’ve set a baseline for your project and recorded actual information.

New Feature
The Task Inspector pane replaces the Task Driver pane introduced in Project 2007.

Cross-Reference
For more information on setting a baseline and recording actual information, see Chapters 12 and 13.

Deleting Dependencies
You can delete dependencies in several ways:

- Open the Task Information dialog box for the successor task, select the Predecessors tab, click the task name for the link that you want to break, and press Delete.
- Display the Predecessors column in the Gantt table, click the Predecessors cell for the successor task, and either press Delete to delete all relationships or edit the predecessor information in the cell.
- Select the tasks that are involved in the dependency you want to delete, click the Task tab, and then (in the Schedule group) click the Unlink Tasks button.
- Double-click the dependency line, and click the Delete button in the Task Dependency dialog box.

Note
If you delete a dependency for an automatically scheduled task, the task bars shift accordingly to reflect any new timing. If you delete a dependency for a manually scheduled task, Project makes no changes to the task’s timing — honoring the duration, start date, and finish date you supplied or created when you first established the dependency.
Summary

In this chapter, you read more about the timing of tasks, including how to set task durations and dependencies. You now should know how to do the following things:

- Differentiate between resource-driven and fixed scheduling
- Establish task durations
- Assign calendars to tasks
- Create recurring tasks
- Establish constraints and deadline dates
- Add and view task notes
- Set, view, and delete dependencies

In Chapter 5, you begin to assign resources to tasks and to find out more about the relationship between resource assignment and task timing.
Creating Resources and Assigning Costs

The “management” portion of the term project management suggests that you are overseeing and, supposedly, controlling what goes on during the project’s lifetime. In the last chapter, you found out how to build the tasks that comprise the project. Now you need to identify the resources for each task. Some tasks require people only; other tasks may also require equipment.

As you create resources, you see that you can associate various rates with a resource. As you assign the resource to a task in your project, Microsoft Project automatically begins to calculate the cost of your project.

Understanding Resources

Resources are the people, supplies, and equipment that enable you to complete the tasks in your project. In Project, you can define four types of resources:

- Work resources
- Material resources
- Generic resources
- Cost resources

Work resources are people or equipment that consume time when working on a task. When you set up work resources, you define the amount of time that the resources have to spend on a project (100 percent is full-time).
Similarly, when you assign a work resource to a task, you indicate the amount of time that you want the work resource to spend on the task (100 percent is full-time).

*Material resources* are items that are consumed while working on a project. Material resources use, well, materials such as gasoline or wood — as opposed to time. When you assign a material resource to a task, you specify the amount of the material resource that you intend to use in units that are appropriate for the material resource. You can also indicate whether the amount of material used is based on time. For example, the number of gallons of water that are used when watering a lawn depends on the amount of time that you run the water and the number of gallons per hour that flow from the faucet. Or, you can indicate that the amount of material is fixed. For example, you need five 2 x 4’s to construct a bench — regardless of how long you take to build the bench.

*Generic resources* are resources (as defined by you) that aren’t specific people, equipment, or materials, but rather descriptions of the skills that you need for a task when you don’t know what specific resources are available. Although this generic resource feature was designed to work in conjunction with the Resource Substitution Wizard and Enterprise Resources (available in Project Server), you may find generic resources handy even if you don’t use Project Server. For example, you can use generic resources when you don’t care who does the work — you simply want to track the work that is completed on a project.

**Cross-Reference**

If you’re using Project Server, you can also take advantage of three related features. You can define Enterprise Resources — resources that are available company-wide for projects. You can use the Build Team page to help you select resources for your project from the Enterprise Resource pool, and you can use the Resource Substitution Wizard to replace generic resources with actual resources. Read more about all these features in Chapter 22.

Using a *cost resource*, you can add a fixed cost to a task without making the cost depend on work performed. If one or more tasks in your project require that you rent a storage unit during part of the project, you can set up the storage unit as a cost resource that you can assign to tasks during the appropriate periods to account for the cost of the storage unit as part of the task. Or, suppose that a resource needs to fly from Salt Lake City to Chicago to complete a task; you can set up the airline tickets as a cost resource and add them to the task.

Resources cost money and therefore affect the cost of the project. To manage a project effectively, you should define resources and assign those resources to tasks in the project. Thus, you need to know how Project uses those resource assignments to change the duration and length of your project.

**Tip**

If you’re not using Project Server and expect to use the same resources for several projects, consider setting up those resources in a special project that contains no tasks. Then you can use Project’s resource-pooling feature and the “resource project” to share the same resources across multiple projects. This approach enables you to set up resources once and then use them repeatedly on many different projects. For more information about resource pooling, see Chapter 19. If you use Project Server, see Chapter 22 for more information about setting up Enterprise Resources.
How resources function in Project

By defining and then assigning resources in Project, you accomplish the following goals:

- You can keep track of the tasks that are being performed by resources — because Project identifies the resources that are assigned to each task.
- You can identify potential resource shortages that may force you to miss scheduled deadlines and possibly extend the duration of your project.
- You can identify underutilized resources. If you reassign these resources, you may be able to shorten the project's schedule.
- You can determine the cost of each task and your project as a whole.

When the tasks that you create are effort-driven, the resources that you assign to a task affect the duration of the task. For example, if you assign two people to do a job, typically the job gets done in less time than if you assigned only one person to the job. But, you ask, what about the cost? Does the use of additional resources increase the project’s cost? Perhaps yes — perhaps no. You may find that completing the project in less time (by using more resources) saves you money because you can accept more projects. Or you may be eligible for a bonus if you complete the project earlier than expected, and the bonus may cover or exceed the cost of the additional resources that you used.

How Project uses resource information to affect the schedule

For effort-driven tasks, Project uses the resource information that you provide to calculate the duration of the task and, consequently, the duration of the project. However, if you set up a task with a fixed duration, Project ignores the resources that you assign to the task when calculating the duration of the project. Similarly, if you don’t assign resources, Project calculates the schedule using only the task duration and task dependency information that you provide.

Cross-Reference

See Chapter 4 for information on task durations and task dependencies.

Assigning a resource to a task can affect the duration of the project because work on the task can’t begin until the resource is available. Project uses a resource calendar to define the working days and times for a resource, but the resource’s availability also depends on other tasks to which you’ve assigned the resource.

If the work assigned to a resource exceeds the time that is available, Microsoft Project assigns the resource to the task and indicates that the resource is overallocated. This technique enables you to see the problem and decide how to fix it.
Part II: Getting Your Project Going

How Project gathers cost information
When you assign rates to resources and then assign resources to tasks, Project can calculate the cost of tasks as well as the project. In addition to resource-associated costs, Project also handles fixed costs, which you read more about near the end of this chapter.

Cross-Reference
You can assign rates to resources when you define them, as you see in “Creating a Resource List,” later in this chapter.

Assigning costs enables you to monitor and control the money you’re spending on a project. Project shows you where and how you’re spending your money so you can control when a project’s costs accrue — which, in turn, helps you predict the cash flow needed to pay bills. The cost-related information that Project provides helps you verify the following items:

- The cost of resources and materials for any task
- The cost of any phase of your project, as well as the cost of the entire project

Tip
Cost information that you gather on one project might help you calculate bids for future projects.

Creating a Resource List

Note
If you intend to upload your project into the Project Server database, you may want to assign resources from the Enterprise Resource pool, a company-wide group of resources. See Chapter 22 for details on assigning resources from the Enterprise Resource pool.

Project gives you the option of creating resources one at a time, as you think of them, or entering all (or most) resources by using the Entry table of the Resource Sheet. To display the Resource Sheet, shown in Figure 5.1, click the Resource Sheet view shortcut button at the right edge of the Status Bar. By default, Project displays the Entry table of the Resource Sheet.

Tip
There are lots of ways to get to the Resource Sheet. For example, you can click either the Task or the Resource tab on the Ribbon and, in the View group, click the bottom of the Gantt Chart button or the Team Planner button (Project Standard users, where there is no Team Planner, click the Resource Sheet button) and select the Resource Sheet view. As an alternative, of course, you can click the View tab and, in the Resource Views group, click the Resource Sheet button.
Chapter 5: Creating Resources and Assigning Costs

FIGURE 5.1
The Resource Sheet displays a list of the resources available to your project.

Note
You can switch tables by clicking the View tab and, in the Data group, clicking the Tables button. Each table contains columns pertinent to its name. For example, the Cost table shows columns that pertain to a resource’s cost.

If you use the Resource Sheet to define most of the resources for your project, the process of assigning resources goes much faster because you don’t have to stop to create the resource first. Also, using the Resource Sheet is a safe way to define resources; the visual presentation helps you avoid accidentally creating the same resource twice. For example, if you’ve defined both Vicki and Vickie, Project sees two resources, even though you may have simply misspelled the name the second time.

You can enter the basics for the resource by filling in the Resource Sheet; simply press Tab to move from field to field (cell to cell). The Resource Sheet shown in Figure 5.1 does not show all the fields described in this section. Scroll to the right to see the rest of the Entry table of the Resource Sheet.
Tip
You can customize the Resource Sheet to show many additional fields that you may want to set up for each resource. For example, if you need to manually enter e-mail addresses for each resource, you can easily add the E-mail Address column to the Resource Sheet.

Cross-Reference
See Chapter 7 to find out how to insert a column in a table.

A field is a cell in a table into which you type appropriate information. All table and form views contain fields. Each field on the Resource Sheet serves a specific purpose, as follows:

- **Indicators**: Although you can't type in the Indicators field, icons appear there from time to time. Some of the icons appear as Project's response to an action you've taken. For example, you might see an indicator for an overallocated resource. In other cases, the indicator appears because you entered a note about the resource. See the “Adding notes to a resource” section, later in this chapter, for more information.

Tip
If you rest your mouse over an indicator, Project displays the information that is associated with the icon.

- **Resource Name**: Type the name of the resource. For a person, you can type the person's name or you can type a job description, such as Product Analyst 1 or Product Analyst 2.
- **Type**: Use this column to specify whether you're defining a human, material, or cost resource.

Tip
Project refers to human resources as Work resources.

- **Material Label**: For material resources, specify the unit of measure. You can set up any label you want. For example, you can use minutes for long-distance phone time, feet for lumber, or miles for vehicle usage.
- **Initials**: Type initials for the resource, or accept the default that Project provides, which is the first letter of the resource name. This designation appears on any view to which you add the Initials field. Typically, a resource's name appears, but you can customize the view to display initials if you prefer.
- **Group**: Assign resources to groups if they share some common characteristic, such as job function. Then you can use this field as a filtering or sorting mechanism and display information about the group (in this example, a particular job function) as opposed to a specific resource. Just type a name to create a group.

Tip
Be sure to spell the group name the same way every time you use it if you want to filter or sort resource information by group later on.
Max. Units: Project expresses the amount of a Work resource you have available for assignment as a percentage of time spent at work. For example, 100 percent equals one unit, or the equivalent of all the working time one resource can provide (which can be part-time or full-time); normally over 100 percent is the point at which a resource is considered overallocated. By the same token, 50 percent equals one-half of a unit, or one-half of a full-time resource’s available working time; 200 percent equals the available work time of two full-time resources.

Std. Rate: The standard rate is the rate typically charged for a resource’s work. Project calculates its default standard rate in hours, but you can specify other time increments. (For Work resources, you can use minutes, days, weeks, months, or years. For material resources, think of the charge as per unit based on the Material Label.) To specify a time increment other than hours, type a forward slash and then the first letter of the word representing the time increment (for example, to charge a resource’s use in days, type /d after the rate you specify).

Ovt. Rate: The overtime rate is the rate charged for any overtime work that a Work resource provides. Again, Project calculates the default rate in hours, but you can change the default unit just as you can for the standard rate.

Cost/Use: In the Cost/Use column (read as “cost per use”), you supply a rate for costs charged for each use of a particular resource. Resource costs may be based on the Standard rate (which is calculated by multiplying the number of hours times the cost per hour), on the Cost/Use rate (a fixed fee for use of the resource), or on a combination of the two. Project uses a combination of the Cost/Use field and the Std. Rate field when it calculates the cost of a task. If you rented a piece of equipment that costs you $25/hour plus a setup charge of $100, you would assign a Std. Rate of $25/hour and a Cost/Use of $100.

Accrue At: This field specifies how and when Project charges resource costs to a task at the standard rate or the overtime rate. The default option is Prorated, but you also can select Start or End, with the following results:
- If you select Start and assign that resource to a task, Project calculates the cost for a task as soon as the task begins.
- If you select End and assign that resource to a task, Project calculates the cost for the task when the task is completed.
- If you select Prorated and assign that resource to a task, Project accrues the cost of the task as the assigned resource completes scheduled work.

Accrue At field to determine whether the cost is applied at the beginning or end of the task. If you set the Accrue At field to Start or Prorated, Project charges the cost at the beginning of the task. If you set the Accrue At field to End, Project charges the cost at the end of the task.

Base Calendar: Here you identify the calendar that Project should use when scheduling the resource. The calendar identifies working and nonworking time. Project assumes that each resource uses the Standard calendar, but as you read later in this chapter, you can create calendars for resource groups (perhaps to handle shift work) or you can modify an individual resource’s calendar to reflect vacation or other unavailable time (such as jury duty).
Part II: Getting Your Project Going

- **Code**: You can use this field as a catch-all field to assign any information that you want to associate with a resource, using an abbreviation of some sort. For example, suppose that your company uses cost-center codes. You may want to supply the appropriate cost-center code for the resource in the Code field. You can sort and filter information by the abbreviations that you supply in the Code field.

**Note**

After you create a resource, Project displays the resource’s ID number on the left edge of the Resource Sheet, to the left of the Indicator column.

### Modifying Resource Information

You just learned a quick way to set up a resource — by entering it on the Resource Sheet. In addition, you can use the Resource Information dialog box to fine-tune any resource’s definition. To display the Resource Information dialog box, double-click any resource on the Resource Sheet or click the Resource tab and, in the Properties group, click Resource Information.

Using the Resource Sheet, you already provided most of the information on the General tab, so this section discusses the fields in the dialog box that didn’t appear by default on the Entry table of the Resource Sheet.

### Assigning a communication method

In the Resource Information dialog box, use the **Email** field (see Figure 5.2) to supply the e-mail address of a particular resource.

![FIGURE 5.2](image)

Use the General tab of the Resource Information dialog box to add information about a resource, such as an e-mail address or availability.
Chapter 5: Creating Resources and Assigning Costs

Note
If you’re using Outlook and you’ve stored the resource’s e-mail address in your address book, you can click the Details button in the Resource Information dialog box. When you do, Project tries to access Outlook — you must provide permission — and opens the appropriate Outlook Contact record. You can then copy the e-mail address from the Contact record and, in Project’s Email field in the Resource Information dialog box, press Ctrl+V to paste the e-mail address.

Specifying resource availability
Suppose that you set up a resource to represent a specific job, such as Intern, as shown in Figure 5.3. And suppose that you have more than one person who can serve as this resource, but not at all times. Using the Resource Availability table (refer to Figure 5.3), you can specify the time periods for which the resource will be available. Figure 5.3 shows that three interns are available from June 1 through July 31 and only one intern is available from August 1 through August 31.

FIGURE 5.3
Use the Resource Availability table to identify when a resource is available.

Note
You can contour the availability of resources you have identified for your project; see Chapter 11 for more information.

Specifying a booking type
You can specify a booking type for a resource assignment. Booking types are most useful in an enterprise environment that has implemented Project Server, where you are utilizing the Enterprise Resource Pool.
The Booking Type field offers you two choices: Committed and Proposed (see Figure 5.4). When you commit a resource, you are officially assigning the resource to the project. When you propose to use a resource, you are indicating that the resource is not yet officially assigned to the project — which leaves the resource's calendar untouched by the proposed assignment to your project.

**Note**
Project does not consider proposed bookings when calculating resource allocation. Thus another project manager could commit the same resource to a different project for the same time frame, and Microsoft Project would not identify the resource as being overallocated.

**FIGURE 5.4**
Specify whether to commit a resource or simply propose its use.

**Tip**
The Booking type you choose for a resource applies to all tasks in your project to which you assign the resource.

**Creating a Generic resource and assigning custom fields**
The Intern resource discussed in the previous section is essentially a generic resource — it’s a job description, not a person (at least not yet). To mark a resource as generic, place a check mark in the Generic box on the General tab of the Resource Information dialog box (refer to Figure 5.4). Your company may have set up custom fields in Project that apply to your generic resource. To
assign the appropriate custom fields, click the Custom Fields tab and assign any appropriate values to your generic resource, as shown in Figure 5.5.

**FIGURE 5.5**
You can assign custom fields to Generic resources to describe the skills that are required.

![Custom Fields Tab](image)

**Cross-Reference**
See Chapter 16 for more information about creating custom fields.

When you click OK to close the dialog box, you see an icon in the Indicator column like the one shown in Figure 5.6. This icon signifies that the resource is Generic.

**Creating a budget resource**
You also can set up a budget resource — another useful stand-in for a real resource, this one made of estimated costs. Project provides budget resources so you can specify how work or costs will be allocated during the project. Suppose, for example, that you want to create a budget for the cost of a storage unit required during the life of your project. You would create a resource for the storage unit, setting its type as Cost, and then check the Budget check box on the General tab of the Resource Information dialog box to make it a budget resource (see Figure 5.7).

Project doesn’t allow you to enter any cost information for a budget resource on the Resource Sheet. To assign a value to the budget resource, you first assign it to the project summary task — but Project won’t let you assign a value as you assign the budget resource. Instead, you supply a value by adding the **Budget Cost** field to the table in the Task Usage view or the Resource Usage view.
Part II: Getting Your Project Going

**FIGURE 5.6**
Identify Generic resources by the icon that’s shown in the Indicator column.

**FIGURE 5.7**
If you set up a Cost resource as a budget resource, you can use it to budget for your project.
Tip
Project doesn’t display the project summary task by default. To display it, start in a task-oriented view such as the Gantt Chart view. Click the Format tab for the view — in my example, click the Gantt Chart Tools Format tab — and, in the Show/Hide group, select the Project Summary Task check box. Note that the Task Mode for the project summary task is Auto Schedule, and you cannot change that value.

Cross-Reference
See Chapter 7 for details on inserting columns to add a field to a view.

You also can set up a work budget resource that you can use to budget for the number of hours of work you intend to perform for the entire project. You then assign the Work budget resource to the project summary task. To record the number of hours of work you want to budget for the entire project, add the Budget Work field to the Task Usage view or the Resource Usage view and enter your budget value. As you track the work for your project’s tasks, you can compare the work performed with the budgeted work.

Adding notes to a resource
Click the Notes tab of the Resource Information dialog box. The Notes text box, shown in Figure 5.8, is a free-form text box in which you can type any information that you want to store about the resource. For example, you may want to store a reminder about a resource’s upcoming vacation or an explanation about resource availability.

After you type text in this box and click OK, a Note indicator icon appears in the Indicator column on the Resource Sheet, as shown in Figure 5.9.

FIGURE 5.8
Use this text box to store information about a resource.
FIGURE 5.9

No need to reopen the Resource Information dialog box to read a note. Instead, place your mouse pointer over the icon in the Indicator column to display the contents of the note.

Note
If more than one indicator appears in the Indicator column, Project displays information about all indicators when you point to the Indicator column.

Calendars and resources
Project uses a base calendar called the Standard calendar to calculate the timing of the project. When you first create a resource for your project, Project uses the Standard base calendar as the default (an eight-hour day and a 40-hour week) if you haven't selected a different calendar in the Project Information dialog box. You can modify working times and create calendar exceptions for resources to accommodate a different work week or planned vacation time.

Note
The entire project has a Standard calendar, and each resource also has his or her individual Standard calendar. Tasks can also have calendars; see Chapter 4 for information on task calendars.
Modifying a resource’s working hours

Suppose that a specific resource won’t be available all day on a given day, or even on several specified days. For example, suppose that all the interns work from 1:00 p.m. to 6:00 p.m. on weekdays. You can change the working hours of a resource by using the Resource Information dialog box. To change the work week for Interns, follow these steps:

1. Double-click the resource on the Resource Sheet to open the Resource Information dialog box.
2. On the General tab, click the Change Working Time button.
   Project displays the resource’s calendar with today’s date selected. Current working times appear to the right of the calendar.
3. Click the Work Weeks tab (see Figure 5.10).
4. Click the [Default] work week already defined for the calendar by Project.

   ![Figure 5.10](image)
   To modify the default work week, select [Default] on the Work Weeks tab.

5. Click the Details button. Project displays the Details dialog box (see Figure 5.11).
6. Select the day(s) you want to change on the left side of the dialog box.
Use this dialog box to redefine a work week.

**Tip**
To select multiple days, use Windows selection techniques. To select contiguous days, click the first day. Then, press and hold the Shift key while clicking the last day. To select noncontiguous days, press and hold Ctrl as you click each day you want to select.

1. Select the Set Day(s) to These Specific Working Times option.
2. In the Working Times section, define the working time for the selected day.
3. Click OK. Project redisplays the Change Working Time dialog box.

When you change the work week, the change you make is not considered an exception; instead, it's considered the normal work week. So you won't notice any changes to the calendar in the Change Working Time dialog box. However, you can identify the working time for any day by clicking that day on the calendar; the working time appears to the right.

**Cross-Reference**
To avoid overallocating a resource that works part of a day, level the resource on a day-by-day basis. Read more about leveling and handling overallocations in Chapter 11.

**Blocking off vacation time**
In the real world, human resources take time off from work. To avoid overallocating a person by assigning work during a vacation period, you should mark vacation days as an exception on the team member's calendar. Follow these steps:

1. Double-click the resource on the Resource Sheet to open the Resource Information dialog box.
2. On the General tab, click the Change Working Time button. Project displays the resource's calendar with today's date selected.
3. Click in the Name column on the Exceptions tab and type a name that helps you remember the purpose of the exception (see Figure 5.12).

![Figure 5.12](image-url)

Figure 5.12
To set up a working time exception, type a name for the exception and set dates.

4. Click in the Start column and select the date on which the exception starts.
5. Click in the Finish column and select the date on which the exception ends.

Click anywhere outside the Finish column, and Project sets every day between the starting and ending dates as an exception on the calendar. In addition, the Details button and the Delete button become available (see Figure 5.13).

**Note**
By default, Project sets any exception you create as nonworking time, but if you need to describe the exception more fully, click the Details button. In the Details dialog box, you can define the details of a working time or a nonworking time exception. For example, you can change a resource’s working time for a particular day by using the Details dialog box. Also, if appropriate, you can set up the exception as a recurring exception.

6. Click OK twice to save the exception.
Assigning Resources to Tasks

You've spent a lot of time in this chapter defining resources and fine-tuning your resource definitions. Now you can finally assign resources to tasks. As noted earlier in this chapter, defining your project’s resources helps you to manage your project more effectively, both in scheduling and in cost.

Assigning resources to tasks

You can easily assign resources to tasks from the Gantt Chart view. Click the Gantt Chart view shortcut at the right edge of the Status Bar or click the top of the Gantt Chart button in the View group on the Task tab of the Ribbon to switch to the Gantt Chart view. Then follow these steps to assign resources to tasks:

1. Select the task to which you want to assign a resource.
   
   You can click the task bar on the Gantt Chart, or you can click any column in the Gantt table.

2. Click the Resource tab and, in the Assignments group, click the Assign Resources button to open the Assign Resources window (see Figure 5.14).
FIGURE 5.14
Use the Assign Resources window to assign a resource to the task identified at the top of the box.

3. Select the resource you want to assign from the Resource Name list of the Assign Resources dialog box.

Tip
Did you forget to define a resource you’re trying to assign? You don’t need to return to the Resource Sheet. Just enter the name of the resource in the Resource Name column of the Assign Resources dialog box.

4. (Optional) If you’re using Project Server and you intend to use the Resource Substitution Wizard, in the R/D field enter an R for Request to indicate that any resource with the required skills can work on the task. Or, enter a D for Demand to indicate that the selected resource is specifically required to work on the task.

Cross-Reference
For more information about resource substitution, see Chapter 22.
5. Do one of the following to assign the amount of a resource:
   - To assign any amount other than 100 percent of a resource, type the quantity as a percentage in the Units column. (Project applies units in percentages, so 100 percent equals one unit of the resource.)
   - To assign one unit (100 percent) of a resource, leave the Units column blank, because Project assigns 100 percent by default.

**Note**
You don’t need to type the percent sign (%); Project assumes percentages. For example, if you enter 50, Project converts your entry to 50%. Keep in mind that you can’t assign less than 1% of a resource’s time.

6. Click Assign.
   Project places a check mark in the leftmost column of the Assign Resources window to indicate that the resource is assigned to the selected task, and Project calculates the resource’s cost using the cost you supplied when you defined the resource.

7. Repeat Steps 3, 4, and 5 to assign additional resources to the selected task, or to select another task in the project; then repeat Steps 3, 4, and 5.

8. When you finish assigning resources, click Close.

**Assigning a budget resource**
To assign a budget resource to your project, you must first display the project summary task. Start in any task view; for this discussion, I’ll start in the Gantt Chart view. Click the Format tab of the view; in my example, I click the Gantt Chart Tools Format tab. Then, in the Show/Hide group, select the Project Summary Task check box (see Figure 5.15). The first task in your project bears the filename of the project.

After you make sure the project summary task is displayed, follow these steps to assign a budget resource:

1. Click the project summary task and then click the Resource tab on the Ribbon.
2. In the Assignments group, click the Assign Resources button to open the Assign Resources window (see Figure 5.16).
3. Click the budget resource and click Assign. Project places a check in the leftmost column beside the resource to indicate that the resource is assigned to the selected task. You cannot assign any value to the budget resource at this point, so click Close.
To assign a budget resource, you must display the project summary task.

**Note**
While the project summary task is selected, the Assign button will not be available for any resource other than a budget resource.

4. To assign a value to a budget resource, switch to the Task Usage or the Resource Usage view (use the view shortcut buttons at the right edge of the Status Bar or click the View tab on the Ribbon and select a view); in Figure 5.17, I'm using the Task Usage view.

5. To add the budget resource value on a specific day, add the Budget Cost or Budget Work fields to the Details section of the view and enter the budget value. To add the budget resource value to the project, regardless of the timeframe, add the Budget Cost and Budget Work fields to the table portion of the view and enter the budget value for the budget cost or budget work resource.
Part II: Getting Your Project Going

**FIGURE 5.16**
You use the Assign Resources window to assign a budget resource to the project summary task.

Cross-Reference
See Chapter 7 for details on adding fields like Budget Cost or Budget Work to a view.

**Getting help while selecting resources to assign**

You may have noticed a plus sign (+) next to Resource List options at the top of the Assign Resources window. If you click the plus sign, the box expands to provide you with ways to make selecting resources easier (see Figure 5.18).

If you check the Filter By check box, Project presents a long list of ways you can limit the resource list. For example, you can search for only material resources — or you can search for resources in a particular group. (Remember that you can assign resources to groups if the resources share a common characteristic.) If you don’t find the filter that you want to use, you can create your own filter by clicking the More Filters button — and, in the More Filters dialog box that appears, clicking New.
Chapter 5: Creating Resources and Assigning Costs

**FIGURE 5.17**
You can use the Task Usage view or the Resource Usage view to assign budget-resource values to the project summary task.

**FIGURE 5.18**
You can narrow your search for resources by filtering, and you can make additional resources available.
Part II: Getting Your Project Going

How Project Calculates Available to Work Time

Project calculates the value for Available To Work time by using the resource’s calendar, availability contour, and the duration of the task. Based on the resource’s calendar, Project calculates the number of working hours for the selected task. Because the resource’s availability may be reduced by the availability contour and by other assignments, Project multiplies available working hours by the availability contour value and then subtracts existing assignment work hours to determine Available To Work hours.

To see how this works, assume that you have a task to accomplish within a ten-day window and the calendar provides for an eight-hour work day. If Day 3 is a holiday and Days 6 and 7 are the weekend, you have only seven days to complete the task. If you assigned one resource to this task full-time, that resource would be allocated for 56 hours. But if the resource’s availability contour were set to 50 percent, then resource’s availability would be reduced to 28 hours. And if the resource were already assigned to another task for 25 percent of the time on Days 1 and 2 (4 hours), then the resource’s Available To Work hours would be down to 24 hours.

Cross-Reference
See Chapter 7 for information about creating custom filters.

If you check the Available to Work box, you can specify the number of hours you need the resource to work. Project calculates the remaining available hours of each resource for the duration of the task and then compares the results of the calculation with the number of hours that you specified. Resources having available hours equal to or greater than the number you supplied appear in the list, along with the resources that are already assigned to the selected task.

Tip
If you need a resource for 12 days, enter 12d in the Available to work box, and Project converts the value to 96 hours.

You can click the Add Resources button to display a list of sources from which you can select a resource. These sources include the Active Directory, your address book (if you use a MAPI-compliant e-mail program such as Microsoft Outlook or Windows Mail), or Microsoft Project Server— the items that are available in the list depend on your working environment.

Note
When you click Add Resources, one of the options that appears is the Active Directory, a Windows network feature. In a Windows network, the administrator can set up an Active Directory that contains a list of people and the contact information for these people.

The Assign Resources window also contains a Graphs button that you can use to get a graphic representation of a resource’s availability. Be aware that these graphs don’t relate particularly to a task for which you’re considering assignment; instead, they focus on the resource.
Note
Although technically you can select multiple resources to graph, this action may not be very useful when you’re trying to select resources to assign to a task.

The Work variation of the Resource Graph appears in a split view when you click the Graph button in the Assign Resources window (see Figure 5.19). This graph shows the amount of work (regardless of the task) assigned to the selected resource on a day-by-day basis.

If you right-click the graph, you can select a different view for the selected resource. For example, you can select Work Availability and you’ll see basically the inverse of the Work variation of the Resource Graph: Each bar represents available time instead of allocated time.

You can use the scroll bar on the left side at the bottom of the view to scroll through resources; you don’t need to use the Assign Resources window to select a resource.

FIGURE 5.19
This graph shows the amount of work assigned to the resource you selected in the Assign Resources window for the time period displayed.
Some tips about resource assignments

Use the following tips when working in the Assign Resources window to assign resources to tasks:

- You can assign several different resources to the same task by simply selecting each resource. You can select a single resource and immediately click Assign, or you can use standard Windows selection techniques to select several resources and then click Assign only once.

- You can assign a resource to a task on a part-time basis by assigning less than 100 in the Units column. The number you type here represents the percentage of working time that you want the resource to spend on the task.

- You can assign more than one resource by assigning more than 100 in the Units column.

- You can consume material resources in two ways: fixed and variable.

  When you use fixed consumption, you indicate that — no matter how long the task lasts — you'll use the same quantity of the material. For example, to build a swimming pool, you need two tons of concrete — no matter how long it takes you to pour the concrete.

  When you use variable consumption, you indicate that the length of time needed for the task does affect the amount of the material you expect to use. For example, when you mow the lawn with a gas mower, the amount of gas you consume depends on how long you run the mower.

You designate fixed or variable consumption in the Units column of the Assign Resources dialog box. To differentiate between fixed and variable consumption, supply the time rate at which you consume a variable resource, such as “per hour” or “per day.” In Figure 5.20, gasoline is a material resource that is being consumed at a variable rate of $2.75/gallon for 6 hours. Project recognizes the variable consumption because I entered the “per hour” designation as I assigned the units of the resource and Project calculates the cost of using the resource at $33.00 ($2.75/gallon per hour for six hours). If I had simply typed “2 gal,” I would have indicated a fixed consumption rate and Project would have calculated a cost of $5.50 (two gallons at $2.75/gallon) for the material resource, with no concern for the length of time I use it.

After you assign a resource to a task, the resource name appears next to the task bar on the Gantt Chart by default. Depending on the task type that you set, you may be able to use resource assignments to modify not only individual task lengths, but also the entire project schedule. For example, if you assign additional resources to an effort-driven, fixed-unit task, Project shortens the duration of the task. As explained in Chapter 4, the amount of work to be done doesn't change, but the extra concurrent effort shortens the time necessary to get the work done. Or, if you assign a resource to work part-time on an effort-driven task, you may find you can complete several tasks at the same time.

Tip

If you overallocate a resource by assigning more of the resource than you have available, Project displays the resource in red on the Resource Sheet view. Chapter 10 explains how to handle these problems.
Chapter 5: Creating Resources and Assigning Costs

FIGURE 5.20
Indicate variable consumption by supplying the time rate when you specify the amount that you’ll use.

Removing or replacing a resource assignment
To remove a resource assignment, follow these steps:

1. Using the Gantt Chart view, select the task from which you want to remove the resource assignment.
2. Click the Resource tab and, in the Assignments group, click the Assign Resources button to display the Assign Resources dialog box.
3. Highlight the resource you want to remove from the task.
   You should see a check mark next to the resource in the leftmost column of the dialog box.
4. Click Remove, as shown in Figure 5.21.

FIGURE 5.21
Remove resources from tasks by selecting them in the Assign Resources window and clicking Remove.
You can be sure that at some point in your project, you will want to change resource assignments. Follow these steps to switch from one resource to another on a particular task:

1. Select the task for which you want to switch resources.
2. Open the Assign Resources dialog box. (Step 2 in the preceding steps list explains how.)
3. Highlight the resource that you want to remove from the task; a check mark appears next to the assigned resource.
4. Click Replace. Project displays the Replace Resource dialog box, which enables you to easily select replacement resources, as shown in Figure 5.22.

![FIGURE 5.22](image)
The Replace Resource dialog box looks very similar to the Assign Resources dialog box.

5. Highlight each resource that you want to assign, and supply units.
6. Click OK.

**Handling Unusual Cost Situations**

If you’re trying to figure out how long it will take to complete a project, resources go hand in hand with tasks. If you assign costs to your resources, those costs also affect the cost of your project. Assigning a cost to a resource, however, is not the only way to assign a cost to a project. For example, projects can have fixed costs associated with them. This section starts with a quick look at overall project costs — and then focuses on handling unusual cost situations.

**Looking at the project’s cost**

You’ve seen how to assign costs to resources. You’ve also seen how to assign resources to tasks — and, by the transitive property of equality (remember that one from high school algebra?), assigning a resource to which you have assigned a cost causes your project to have a cost. Are you wondering what that cost is? Click the Project tab and, in the Properties group, click Project Information to open the Project Information dialog box. Then click the Statistics button to open the Project Statistics dialog box (see Figure 5.23).
Cross-Reference
Part V covers tracking, recording work done, and analyzing and reporting on progress. Chapter 15 explains additional ways to view project costs. The following sections consider ways to assign unusual costs to a project.

Assigning fixed costs
This chapter has, to this point, focused on resources, and on how to assign costs to a resource. But the costs of some tasks need to be calculated differently. In Project, you can assign a fixed cost to a task or you can assign a fixed resource cost to a task.

Assigning a fixed cost to a task
Some tasks are fixed-cost tasks. That is, you know that the cost of a particular task stays the same regardless of the duration of the task or the work performed by any resources on the task. For example, your catering service, as part of each job, washes linens. You own the washing machine, and you’ve done the calculation on the amount of water plus electricity used (plus wear and tear) each time you run the machine for a wash cycle. Or, you’re renting a site for a meeting for a flat fee. In cases like these, you assign the cost directly to the task. If you assign a cost to a task, Project adds the fixed cost of the task to the cost of any resource work that you assign to the task when calculating costs for the project.

Note
Remember that assigning a fixed cost to a task does not necessarily make the total cost of the task equal to the fixed cost that you assigned. You can, for example, assign more than one fixed cost as well as variable costs to a task.

To assign a fixed cost to a task, use the Gantt Chart view and apply the Cost table. Follow these steps:

1. Click the Gantt Chart view shortcut at the right edge of the Status Bar to switch to the Gantt Chart view.
2. Click the View tab and, in the Data group, click the Tables button; from the list that appears, select Cost to switch to the Cost table view of the Gantt Chart (see Figure 5.24).

![Figure 5.24](image)

Use the Cost table view of the Gantt Chart to assign costs to tasks.

3. Select the task to which you want to assign a fixed cost.

4. In the Fixed Cost column, type the cost for that task and press Enter.

You can control how Project accrues the fixed cost for a task from the Fixed Cost Accrual column. Your choices are Start, Prorated, and End. These choices have the same meaning as the accrual choices for resources discussed in the “Creating a Resource List” section earlier in this chapter.

**Tip**

To control how Project accrues all fixed costs, use the Project Options dialog box. Click the File tab button and, in Backstage view, click Options. Click Schedule on the left side of the Project Options dialog box. Then, use the Default Fixed Cost Accrual list box to select an accrual method.
Assigning a fixed resource cost to a task

Suppose you hire a consultant to perform a task for a fixed amount of money. You can assign the consultant to the task as a fixed-cost resource. First, set up the resource in the Resource Sheet view. If the resource has some sort of “per unit” cost (an hourly or daily rate), assign that rate in the Std. Rate field. Otherwise, assign a standard rate of $0, as I did in Figure 5.25. Supply the fixed-cost amount in the Cost/Use field.

Tip

To keep this example clear, I assigned a Std. Rate of $0 to show you how Project calculates the cost of using the resource as the value you assign in the Cost/Use field, regardless of the amount of time the resource spends working on the task. If your resource has a standard rate, be sure to assign it in the Std. Rate field to make Project add the Cost/Use value to the amount of time the resource spends working on the task.

FIGURE 5.25
Setting up a fixed-cost resource.
Part II: Getting Your Project Going

Next, you can add the resource to the task using the Assign Resources window; click the task to select it. Then click the Resource tab and, in the Assignments group, click the Assign Resources button. In the Assign Resources window, be sure to assign a percentage of units to the resource, even if the resource has a $0 standard rate. After you click Assign, Project automatically adds the fixed cost in the Cost column (see Figure 5.26).

Caution
If you don’t assign units, Project converts the task to a milestone, causing the task to lose its duration.

To view the costs of your tasks — and to see how Project treated the cost of the task to which you assigned a cost/use (cost-per-use) resource, change the table of the Gantt Chart view from the Entry table to the Cost table by clicking the View tab and, in the Data group, clicking the Tables button; from the list that appears, select Cost.

FIGURE 5.26
When you assign a resource with a cost/use to a task, Project displays that cost in the Assign Resources window.
In the Total Cost column, Project assigns the resource’s cost using the rate/hour you supplied in the Std. Rate field on the Resource Sheet plus the cost you assigned in the Cost/Use field, as shown in Figure 5.27. The task’s total cost does not depend entirely on the time that a resource spends working on the task.

**Accounting for resource rate changes**

In some situations, you must charge different rates on different tasks for the same resource. Or you may expect a resource’s rate to change during the life of your project. Project uses cost-rate tables to accurately reflect resource costs as they change. On cost-rate tables, you can identify up to 125 rates for a single resource, and you can identify the effective date of each rate. Cost-rate tables help you to account for pay increases or decreases to human resources during the life of your project, and enable you to charge the same resource at different rates, depending on the task.

**FIGURE 5.27**

Project assigns the cost per use to the task when you assign a resource defined with a cost-per-use value.
Part II: Getting Your Project Going

To assign multiple rates to a resource, use the Costs tab of the Resource Information dialog box. On the Resource Sheet view, double-click the resource for which you want to assign multiple rates. Click the Costs tab in the Resource Information dialog box (see Figure 5.28).

FIGURE 5.28
Use cost-rate tables to assign different rates to a resource.

The Costs tab displays five cost-rate tables (tabs A through E) that you can use to assign different rates to a resource for use on different dates throughout a project’s life. On each cost-rate table, you can enter up to 25 rates for the selected resource and indicate an effective date for each rate. Project uses the effective dates that you supply to apply the correct rate to a resource at different times during the project.

Tip
If you’re specifying a new rate as an increase or decrease of an existing rate, you can specify the new rate in a percentage (such as +10% or –10%); Project calculates the value of the rate for you. You must enter the percent sign.

If you charge different amounts for resources depending on the type of work they perform, you may want to use each cost-rate table tab to represent sets of rates for different kinds of work.

To assign the correct resource cost-rate table to a task, follow these steps:

1. Assign the resource to the task by using the Assign Resources window as discussed in “Assigning resources to tasks” section, earlier in this chapter.
2. Click the Task Usage view shortcut at the right edge of the Status Bar to switch to the Task Usage view (see Figure 5.29).

![Figure 5.29](image)

The Task Usage view shows you the amount of time that a resource is assigned to a particular task.

3. In the Task Name column, double-click the resource for which you want to select a cost-rate table.

The Assignment Information dialog box appears.

4. Click the General tab, shown in Figure 5.30, to select a cost-rate table.
Part II: Getting Your Project Going

**FIGURE 5.30**

Use the General tab of the Assignment Information dialog box to select a cost-rate table.

5. Select the correct cost-rate table from the Cost Rate Table drop-down list.
6. Click OK.

**Tip**

If you use cost-rate tables a great deal, you may want to add the Cost Rate Table column to the table portion of the Task Usage view. Doing so makes it easy to select a cost-rate table without opening the Assignment Information dialog box. See Chapter 7 for details on inserting a column.

---

**Summary**

This chapter detailed more about using resources in Project, including how to create and assign resources to your project. The following topics were covered:

- Creating a resource list
- Modifying resource information, including using calendars for resources
- Assigning resources to tasks and removing resource assignments
- Handling fixed costs, both for individual tasks and for resources
- Assigning either a fixed or variable cost to a material resource
- Setting up different rates for resources to account for pay increases or decreases or for charging resources at different rates on different tasks

Chapter 6 presents the basics of using the standard views in Project.